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Introduction 
This document provides release information about IBM® FileNet® P8 4.5 and has the following major 
topics:  

• What’s new – Describes new features. 

• Known issues – Lists and describes known product and documentation issues. 

This document includes information about the following FileNet P8 components: 

• Application Engine 4.0.2 

• Business Activity Monitor 4.5 

• Content Engine 4.5 

• FileNet Content Federation Services 4.5 

• FileNet P8 Documentation 4.5 

• Process Analyzer 4.5 

• Process Engine 4.5 

• Process Simulator 4.5 

• Records Manager 4.5 

• Rendition Engine 4.5 

• Workplace XT 1.1.3 

Access IBM FileNet documentation, compatibility matrices,  
and fix packs 
To access documentation, compatibility matrices, and fix packs for IBM FileNet products:  

1. Navigate to the Product Documentation for FileNet P8 Platform support page. 

(http://www-1.ibm.com/support/docview.wss?rs=3247&uid=swg27010422). 

2. Select a PDF or a Doc Link, whichever is appropriate. 

Customer support 
For information about contacting customer support:  

1. Navigate to the FileNet Product Family support page:  

(http://www-01.ibm.com/software/data/content-management/filenet-product-family/support.html).  

2. Click IBM FileNet Support Communications, or search for a particular support topic under “Enter 
search terms”.  

Feedback 
Your feedback helps us to provide quality information. Send your comments about this publication or any 
other IBM FileNet documentation by e-mail to comments@us.ibm.com. Be sure to include the name of 
the product, the version number of the product, and the name and part number of the book (if applicable). 
If you are commenting on specific text, include the location of the text (for example, a chapter and section 
title, a table number, a page number, or a help topic title). 

http://www-1.ibm.com/support/docview.wss?rs=3247&uid=swg27010422�
http://www-01.ibm.com/software/data/content-management/filenet-product-family/support.html�
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What’s New 
This section lists the new and improved features contained in this release. 

FileNet P8 Platform 

Staged upgrades 

If you are upgrading from IBM FileNet P8 Platform V4.0 components, including supported expansion 
products, you can choose to upgrade the components independently. This means that you can upgrade 
one component and still have a working configuration without upgrading all components during the same 
upgrade session. For more information, see “Upgrade Overview” in Plan and Prepare Your Environment 
for IBM FileNet P8. 

Simplified application data deployment  

The following features simplify the deployment of application data from one FileNet P8 environment to 
another.  

• FileNet Deployment Manager 

You use FileNet Deployment Manager to replace environment-specific data, such as user names 
and object store IDs, in application data that is extracted from a Content Engine object store. You 
can use this tool for Content Engine core objects, Process Engine workflow definitions, 
Workplace and Workplace XT objects, and eForms objects. You can run Deployment Manager 
from a command line or from a graphical user interface. 

For more information about FileNet Deployment Manager, see FileNet P8 Documentation > 
Application Deployment > Get started with FileNet Deployment Manager. For information about the 
command-line interface, see FileNet P8 Documentation > Application Deployment > Use the 
command line utilities > Deployment command-line reference. 

• Process Engine Export and Import Utilities 

Process Engine includes the following new command-line utilities to assist in exporting and 
importing application data from one Process Engine instance to another: 

o The object utilities consist of two scripts, peObject_export and peObject_import, which assist 
you with exporting and importing queues, rosters, logs, user preferences, and system 
properties.  

o The server utilities consist of two scripts, peServerConfig_export and peServerConfig_import, 
which assist you with exporting and importing server configuration information.  

For more information about these utilities, see FileNet P8 Documentation > Application Deployment 
> Use the command line utilities > Process Engine Export/Import Utilities command-line reference.  

• Application deployment help 

Application deployment is documented in the FileNet P8 Help. Along with detailed procedures for 
deploying custom applications, the help includes deployment maps that identify the classes, 
objects, and other assets that you need to consider when deploying an application. For each 
asset, these deployment maps describe the deployment mechanism, any dependencies on other 
assets, and environment-specific data.  

IBM Support Assistant 

IBM Support Assistant (ISA) is a no-charge support tool that you can download and install on your local 
system. ISA helps you find information and resolve problems with IBM software products. ISA add-ons 
are available for a variety of IBM FileNet products, including the IBM FileNet P8 Business Process 
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Manager, Content Manager, and Application Engine products. An add-on enables ISA to display product-
specific information (such as APARs and technotes). 

Instructions for downloading and installing the ISA are on the ISA Web site:  
www.ibm.com/software/support/ISA/. After you have installed the ISA, you can download product add-
ons. For instructions, see "Find new product add-ons" in the ISA online help. 

Application Engine 

Improved installation and configuration process 

• Starting with fix pack AE-4.0.2-001, all Application Engine fix packs contain all of the software 
necessary to install Application Engine. You no longer need to install a base Application Engine 
release prior to installing a fix pack.  

• Installation program panels have been updated to make choices clearer and to simplify the 
installation process. 

•  The Install and Upgrade Worksheet, new in the FileNet P8 Platform documentation release for 
4.5, includes rows for Application Engine installation program values. You can use the worksheet 
when planning and preparing for your Application Engine installation as part of a FileNet P8 
environment. 

• The Application Engine installation program and the client installation programs for Process 
Engine and Content Engine allow you to defer creating a deployment file. By deferring this step, 
you can bypass creating the deployment file for each installation program. Instead, the last 
installation program can create the file, or you create the file manually before you deploy. 

New access role 

The new PWDiagram access role controls access to Diagram mode in Process Designer. Diagram mode 
provides an easy-to-use tool for business users to create layouts of workflow definitions, including 
documentation to describe business processes. 

Removed root user restriction 

Previous releases required that the user installing Application Engine have root permission. This 
requirement no longer exists. 

Expanded single sign-on support 

Application Engine supports Kerberos/SPNEGO Single Sign On (SSO) using BEA WebLogic Server 10 
and IBM WebSphere® V 7.   

Improved language support 

Application Engine no longer requires language packs to provide a translated Workplace user interface. 
In addition to English, this release provides the Workplace user interface in the following languages:  

 
Language Locale Language Locale 

Arabic AR Japanese JA 

Bulgarian BG Korean KO 

Catalan CA Polish PL 

Chinese 
(Simplified) zh-CN Portuguese (Iberian) PT 

Chinese zh-TW Portuguese pt-BR 

http://www.ibm.com/software/support/isa/�
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(Traditional) (Brazilian) 

Croatian HR Romanian RO 

Czech CS Russian RU 

Dutch NL Swedish SV 

Finnish FI Slovak SK 

French FR Spanish ES 

German DE Thai TH 

Italian IT   

 
NOTE Separate media are available for each language’s Application Integration and File Tracker 
installation programs. 

Business Activity Monitor 

New location for installation instructions  

The installation guide was removed from the IBM FileNet Business Activity Monitor (BAM) Projects. The 
new installation instructions are available in the BAM Quick Start Guide. 

Application name changes 

The following product names have been changed, and the product documentation is updated accordingly. 
 

• FileNet Application Workbench is changed to IBM Cognos Now! Workbench.  

• FileNet Business Activity Monitor is changed to IBM FileNet Business Activity Monitor. 

• FileNet BAM software is changed to IBM FileNet BAM Projects. 

• FileNet BAM Dashboard is changed to IBM Cognos Now! Dashboard. 

• FileNet Operational Dashboard is changed to IBM Cognos Now! Dashboard. 

• FileNet BAM Workbench is changed to IBM Cognos Now! Workbench. 

• FileNet Application Workbench is changed to IBM Cognos Now! Workbench. 

• FileNet BAM Server Reference is changed to IBM Cognos Now! Streaming Server Reference. 

• FileNet BAM Web application is changed to IBM Cognos Now! Web application. 

• FileNet Activity Suite is changed to IBM Cognos Now! 

• FileNet Business Activity Monitor (BAM) Documentation CD is changed to IBM FileNet BAM 
Projects Documentation CD. 

Changes to the "Import Out-of-the-box configuration project" topic 

• The "Import the pre-configured Business Activity Monitor objects" topic is changed to "Import Out-
of-the-box configuration project."  

• The "Configure a context data source to access data from Process Analyzer” section is changed 
to "Configure a JDBC agent." 

• "Configure a JDBC agent" includes SQL Server 2005 examples. 

• The "Other application servers" and "Advanced IBM FileNet BAM functionality" sections have 
been added. 
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New upgrade procedure 

A procedure for upgrading an existing IBM FileNet BAM Project installation has been added. For more 
information, see FileNet P8 Documentation > Expansion Products > Business Activity Monitor > Upgrade an 
existing IBM FileNet BAM Projects installation. 

Improved language support 

In addition to English, BAM provides the user interface in the following languages: 

Language Locale 

French FR 

German DE 
 
The French and German sample project files are located on the media in the following directories: 

\Projects\DE 

\Projects\FR  

Content Engine 

Improved configuration and deployment during installation 

The new Configuration Manager tool is used to configure and deploy Content Engine on an application 
server. Configuration Manager can be run either from a command line or from a graphical user interface. 
It takes the place of manual configuration and deployment steps previously performed using the 
application server administrative interface. 

Improved Enterprise Manager functionality 

• Content Consistency Checker performance improved. 

• Previously you created Index Areas using a dialog in Content Based Retrieval (CBR). The dialog 
has been replaced with the Create an Index Area wizard for greater consistency with other 
creation tasks. 

• You can now use the Create Object Store wizard to revise the object store creation schema 
script. The AddOns installation process is more visible, giving you more flexibility in choosing 
which AddOns to install when the object store is created. Throughout Enterprise Manager, 
AddOns are now consistently listed by their new display names. 

• You can now apply non-versioning security templates to documents, folders, and custom objects. 

• You now can control whether to save the Original and Current snapshots (or none at all) when 
auditing events. 

• You can restrict membership to configured realms. 

• In the Directory Configuration properties, you now can restrict group lookups to configured realms 
only. 

Removed root user restriction 

Previous releases required that the user installing Content Engine have root permission. This requirement 
no longer exists. 
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Support for DITA Rendition Engine 

The Darwin Information Typing Architecture (DITA) Rendition Engine, based on the DITA specification 
1.1, uses the DITA Open Toolkit for rendering. The DITA Rendition Engine publishes DITA content (topics 
and maps) into PDF. 

Improved language support 

In addition to English, Content Engine provides the user interface for the Content Engine properties for 
Workplace and Workplace XT in the following languages: 

Language Locale Language Locale 

* Arabic AR Japanese JA 

* Bulgarian BG Korean KO 

* Catalan CA * Polish PL 

Chinese 
(Simplified) zh-CN * Portuguese 

(Iberian) PT 

Chinese 
(Traditional) zh-TW Portuguese 

(Brazilian) pt-BR 

* Croatian HR * Romanian RO 

* Czech CS Russian RU 

Dutch NL * Swedish SV 

Finnish FI * Slovak SK 

French FR Spanish ES 

German DE * Thai TH 

Italian IT   

 
 * These languages are available only for Workplace.  

FileNet Content Federation Services 

Support for Content Manager OnDemand 

Content Federation Services now supports Content Manager OnDemand as an external repository. 

Integration with Content Engine 

• Content Federation Services supports Image Services and Content Manager OnDemand as part 
of the FileNet P8 Platform installation. Note that CFS support for Content Services, IBM Content 
Integrator, and other supported external repositories requires a separate installation. 

• Content Federation Services supports IBM Content Integrator® V8.5 (formerly Information 
Integrator Content Edition – IICE). 

FileNet P8 Documentation 

Improved planning, preparation, and installation instructions 

• The IBM FileNet P8 documentation set provides a separate customer-oriented environment 
preparation guide, Plan and Prepare your Environment for IBM FileNet P8, which presents 
information that was previously included in the planning and preparation section of the IBM 
FileNet P8 Platform Installation and Upgrade Guide. The topics in this new guide are divided by 



IBM FileNet P8 Release Notes Software Release 4.5.x  
What’s New 

 

© Copyright IBM Corp. 2008  - 15 -       

administrator roles, including Application Server Administrator, Database Administrator, IT 
Administrator, Security Administrator, and P8 Administrator. The guide provides tasks for these 
roles to perform in the customer environment to prepare for the installation or upgrade of IBM 
FileNet P8 components. 

• The documentation set also includes the Installation and Upgrade Worksheet (p8_worksheet.xls). 
The content of this file can be customized to match the customer's installation parameters, and 
further customized by role, so that each administrator at a customer site can configure and collect 
the data needed to complete the installation programs. Each row in the worksheet provides an 
entry for an installation, upgrade, or configuration field or parameter. Using the worksheet in 
conjunction with the Plan and Prepare Your Environment for IBM FileNet P8 guide can simplify 
the installation and upgrade process. The "Glossary" appendix at the end of the Plan and Prepare 
Your Environment for IBM FileNet P8 guide provides definitions for each of the non-obvious 
properties or parameters listed in the worksheet. 

• The Plan and Prepare Your Environment for IBM FileNet P8 guide provides a section called 
"Upgrade Overview." This section presents staged upgrade scenarios in the form of flowcharts to 
help customers understand the ramifications of choosing a staged upgrade for their existing IBM 
FileNet P8 environment. 

• The appendix "IBM FileNet P8 ports," in the Plan and Prepare Your Environment for IBM FileNet 
P8 guide, has been improved with descriptions and explanations of the required or default ports. 

• The IBM FileNet P8 Installation and Upgrade Guide has been re-architected to clarify the 
sequence of tasks necessary to install a specific core component. In addition, all necessary tasks 
are inline for both new installations and upgrades, to prevent the need to flip to different sections 
of the book to complete a task.  

• The procedures in the IBM FileNet P8 Installation and Upgrade Guide have been streamlined to 
provide required independent software vendor settings, but not the detailed instructions for how to 
configure vendor software such as application servers and databases. This will result in fewer 
instances of confusing or outdated instructions specific to these applications. 

• Procedures for installing the Content Engine Client files on the Process Engine and Application 
Engine servers have been added to the IBM FileNet P8 Installation and Upgrade Guide. This 
information was formerly available in the Content Engine fix pack readme file. 

• To support the new Content Engine Configuration Management tool, the "Configuration Manager 
reference" appendix has been added to the IBM FileNet P8 Installation and Upgrade Guide to 
provide reference information for the graphical-user-interface and command-line versions of the 
tool. To augment this documentation, rollover context-sensitive help has been added to the tool's 
graphical user interface to explain screen elements. 

New location for the upgrade instructions for custom applications 

The "Upgrade Custom Applications" section of the IBM FileNet P8 Platform Installation and Upgrade 
Guide has been moved to the FileNet P8 Platform Help. See FileNet P8 Documentation > Developer Help > 
Upgrade Custom Applications. 

Process Analyzer 

Improved language support 

Process Analyzer no longer requires language packs to provide a translated user interface. In addition to 
English, this release provides the user interface in the following language:  

Language Locale 

Japanese JA 



IBM FileNet P8 Release Notes Software Release 4.5.x  
What’s New 

 

© Copyright IBM Corp. 2008  - 16 -       

Support for separate database servers 

The Analysis Services server and the Process Analyzer Database server can now reside on different 
database servers. 

Improved event log processing 

Process Analyzer server can be configured to process events from specific isolated regions or specific 
event logs. 

Process Engine 

Process Engine Export and Import Utilities 

Process Engine includes the following new command-line utilities to assist in exporting and importing 
application data from one Process Engine instance to another: 

• The object utilities consist of two scripts, peObject_export and peObject_import, which assist you 
with exporting and importing queues, rosters, logs, user preferences, and system properties.  

• The server utilities consist of two scripts, peServerConfig_export and peServerConfig_import, 
which assist you with exporting and importing server configuration information.  

For more information about these utilities, see FileNet P8 Documentation > Application Deployment > Use 
the command line utilities > Process Engine Export/Import Utilities command-line reference. 

New features for Process Designer 

• Membership in the appropriate access role enables specific functionality in Process Designer, 
including access to Diagram mode, to configuration and administration features, and to simulation 
features. 

• Diagram mode in Process Designer provides an easy-to-use tool for business users to create 
layouts of workflow definitions, including document to describe business processes. These 
diagrams provide the starting point for collaboration between the business user and the IT 
developer to create the fully functional workflow definition in Design mode. 

• Configuration and administration tools are integrated into Process Designer to minimize steps 
and tools required to create solutions. You can make configuration changes, such as adding 
queues and rosters. After you launch a workflow, you can access work items using Personal 
Work Manager, and you can use Process Administrator to administer the running workflow. 

• You can insert new or existing scenarios into the workflow collection. A scenario can include one 
or more of the workflow definitions in the collection. In Process Designer, you can launch the 
scenario to create the simulation, and you can use Simulation Console to manage the simulation. 

• Process Designer has a tabbed interface to support multiple workflow definitions, scenario 
definitions, configuration, roles, and in-basket panels. You can switch between the workflow 
definitions, configuration settings, scenario definitions, and other options by clicking the 
appropriate tab. 

• Support for Web 2.0 components (widgets) enables rapid development of BPM applications 
without coding. You can combine IBM ECM Widgets with industry and custom widgets to create 
process application interfaces. Use Process Designer and Process Configuration Console to 
define application spaces that specify security and roles, and in-baskets that provide a filtered 
view of tasks for users who fill a specific role in the process. This functionality is available as an 
optional expansion product. 

• You can register step processors in Process Designer, as well as in Process Configuration 
Console. 
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• Menu items and locations have changed. 

o The File menu options apply to the workflow collection. Additionally, the Import Workflow 
option is no longer available; use the Insert command instead. 

o The Edit menu now contains the Change Step Type and Create Map options, which were 
previously in the Tools menu. 

o The View menu now supports the tabbed interface to enable you to select workflows, 
scenarios, the Configuration Console, Roles, and In-baskets.  

o The Action menu items apply to the individual workflow definition or scenario on the selected 
tab. It also contains Workflow Properties, and print options. 

o The Tools menu now provides access to Personal Work Manager, Process Administrator, 
and Simulation Console, if you are a member of the appropriate access roles. The tools that 
were previously on the Tools menu have been moved to the Edit, Action or Settings menus. 

o The Help menu provides access to the online help and the tutorials. 

o Options that were available in the Workflow Collection dialog box are now available on the 
View, File, and Actions menus or on the Workflow Properties > Advanced tab. 

New features for Process Configuration Console 

• You can export all Process Engine settings or select specific isolated regions, queues, rosters, 
and event logs to XML. 

• Support for Web 2.0 components (widgets) enables rapid development of BPM applications 
without coding.  

• You can specify application spaces, roles, and in-baskets in Process Configuration Console. 

Improved accessibility 

Process Administrator and Process Configuration Console options can now be accessed using the 
keyboard or assistive software, such as screen readers. 

New Content Extended Operations 

New Content Extended (CE) Operations methods are available to manipulate documents and folders in a 
repository. 

Process Simulator 

Improved language support 

Process Simulator no longer requires language packs to provide a translated user interface. In addition to 
English, this release provides the user interface in the following languages:  

Language Locale Language Locale 

Czech CS Italian IT 

French FR Japanese JA 

German DE Spanish ES 
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Records Manager 

New auto-destroy feature 

Records Manager introduces the auto-destroy feature that, when configured, automatically deletes 
records at the end of their retention schedule without involving workflow functionality. 

Container-managed authentication and single sign-on  

Records Manager can now be deployed in a container-managed authentication environment and in a 
single sign-on (SSO) environment. For more information about supported SSO software, see IBM FileNet 
P8 Hardware and Software Requirements.  

New Declassification Sweep utility 

Declassification Sweep is a new Records Manager utility that alters the date on which a classified record 
will be declassified based on a pre-defined declassification timeframe.   

New report for entities due for an interim transfer 

Records Manager Disposition Sweep has a new parameter that generates a text file of entities that are 
due for an interim transfer by a specified date. 

Improved language support 

The Records Manager user interface is multilingual, and users can select a language based on the 
browser locale, which is now consistent with FileNet P8 Workplace and Workplace XT. 

The language pack content is now included in the English installation program. This eliminates the need 
to download and run a separate language pack. 

The installation and configuration instructions for non-English environments are now integrated into the 
IBM FileNet Records Manager Installation and Upgrade Guide. 

The following table lists the available languages for the user interface. 

Language Locale Language Locale 

Arabic AR German DE 

Catalan CA Italian IT 

Chinese (simplified) ZH_CN Japanese JA 

Chinese (traditional) ZH-TW Korean KO 

Czech CS Portuguese (Iberian) PT 

Dutch NL Portuguese (Brazilian) PT-BR 

Finnish FI Spanish ES 

French FR   

Customizable report templates 

Records Manager reports can be customized and translated. This can be accomplished in multilingual 
environments by customizing and translating the report templates so that the reports can be created in 
any of the available languages. 
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Improved multi-threading process control 

You can now specify the number of simultaneous processing threads that Records Manager can use 
when running: 

• Hold Sweep 

• Disposition Sweep  

• Auto-destroy 

Improved object store configuration wizard 

The Records Manager Configure tab now provides the capability to configure new object stores for 
Records Manager use, and make upgrades to existing Records Manager object stores.   

New system-to-system transfers utility 

The Records Manager Transfer Tool is a new Records Manager stand-alone utility that transfers active 
records and folders to an external system for permanent archiving.  

New workflows with mapping 

Records Manager has three new workflows that you can associate with a disposition action: 

• Export transfer with mapping 

• Interim transfer with mapping 

• Two-step transfer with mapping 

These new workflows allow you to select a transfer mapping that Records Manager uses during the 
disposition action. 

Rendition Engine 

Updated rendering engine 

Rendition Engine is now based on Liquent Enterprise Services (LES) 3.0. 

Expanded application support 

Rendition Engine now supports Microsoft Office 2007. 

Expanded platform support 

Rendition Engine now supports installations on the following components: 

• 64-bit Windows® 2003 

• Oracle 11 

Automated Vista Domain handling 

The server on which the Rendition Engine is installed will automatically be added as a COM Repository to 
a new Vista domain if none exists in the database location specified, or else added to the existing Vista 
domain. 

New default installation location 

The default installation location is: C:\Program Files\FileNet\RenditionEngine\Liquent 
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Workplace XT 

Improved user interfaces 

• Entry templates and the Add Folder wizard have been updated with the same easy-to-use steps 
and controls as the Add Document wizard.  

• Adding documents using drag-and-drop opens an entry template where appropriate. 

• The folder Properties page has been updated with the same easy-to-use features as the 
document Properties page. 

• The Advanced Search page uses improved folder and class selection interfaces. 

• The Move, File, and Unfile actions have been updated to use the new Workplace XT look-and-
feel. 

• The current folder’s contents can be easily refreshed directly from the toolbar. 

• Bookmarked folders, stored searches, and search templates open using the standard Workplace 
XT interface. 

Folder customizations 

• An administrator can customize the displayed columns and default sort order for each folder. 

• An administrator can associate entry templates with specific folders and specific document types. 

Expanded support for other repositories 

• Documents stored on a Content Manager OnDemand (CMOD) server can be viewed using 
CMOD viewers. 

• Documents stored on a CM8 server can be viewed. 

Improved integration with Office applications 

• Application Integration BCS integrates Microsoft Office 2007 applications and Outlook with 
Workplace XT. Integrated Office applications and Outlook provide access to object stores and 
some of the Workplace XT features, allowing you to perform and complete your document 
management tasks without leaving the applications. New features include: 

o Add documents and e-mails using entry templates. 

o Browse and search for documents.  

o Add documents and folders to the Favorites folder. 

o View and modify document properties. 

o Open documents recently accessed from an object store. 

o Check documents in and out of an object store. 

o E-mail a link or copy of a document. 

o Access document management actions and tools from the familiar Microsoft Office 2007 
Ribbon. 

o Control Application Integration BCS behavior using site preferences. 

• Single sign-on (SSO) using Kerberos is supported with integrated Office applications. 
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Improved search capabilities 

• The Advanced Search page has been improved to allow keyword searches in addition to property 
searches. 

• Keyword search results can, in many cases, be resorted by columns in the search results. 

Improved installation and configuration process 

• Installation program panels have been updated to make choices clearer and to simplify the 
installation process. 

•  The Installation and Upgrade Worksheet (p8_worksheet.xls) includes rows for Workplace XT 
installation program values. You can use the worksheet when planning and preparing for your 
Workplace XT installation as part of a FileNet P8 environment. 

• The Workplace XT installation program and the client installation programs for Process Engine 
and Content Engine allow you to defer creating a deployment file. Deferring this step allows you 
to bypass creating the deployment file for each installation program. Instead, the last installation 
program can create the file, or you create the file manually before you deploy. 

Removed root user restriction 

Previous releases required that the user installing Workplace XT have root permission. This requirement 
no longer exists. 

New access role 

The new PWDiagram access role controls access to Diagram mode in Process Designer. Diagram mode 
provides an easy-to-use tool for business users to create layouts of workflow definitions, including 
document to describe business processes. 

Improved language support 

In addition to the 11 languages already supported, Workplace XT provides a translated user interface for 
the following new languages: 

 

Language Locale 

Finnish FI 

Russian RU 
 
NOTE Separate media are available for each language’s Application Integration and File Tracker 
installation programs. 

Other improvements 

• The Send Mail action is integrated with the user’s Lotus Notes or Microsoft Outlook e-mail client. 

• The values of multi-valued properties are displayed in the list view. 

• Improved error messages when configuring site preferences help administrators to resolve 
configuration errors more easily. 

• Improved error messages in Application Integration BCS provide more assistance to the user 
when resolving errors. 
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Development Tools 

Content Java™ API Compatibility Layer 

Encryption Algorithm Change  

The use of the Blowfish encryption algorithm for encrypting session tokens is replaced by the FIPS 140-
compliant Advanced Encryption Standard (AES) algorithm. 

When testing encryption of credentials tokens during application development, you can run the 
MakeCryptoKeys utility from a command line to manually generate one or more encryption keys. Under 
the Blowfish algorithm, the range of allowed key sizes was 8 to 448 in increments of 8 bits. Allowed key 
sizes for AES are 128 (the default), 192, or 256 bits. If you specify a size greater than 256 bits, the 
MakeCryptoKeys utility generates a warning and reduces the value to 256 bits. Values that are not 
exactly 128, 192, or 256 are rounded down. 

See the Known Issues section of this Release Notes document for additional information, including 
updates to the MakeCryptoKeys class documentation (ecmdb00755693). 

Content Engine Object Model Changes 

This section lists the Content Engine classes, interfaces, and properties that have been added in this 
release as well as the properties that have been deprecated. Note that there are a number of new 
exposed interfaces and properties—primarily those that are replication-related—that currently are not 
supported. The replication-related interfaces and properties that are supported are those used for Content 
Federation Services (CFS) functionality. 

New classes and interfaces 

The following classes and interfaces have been added to the Content Engine object model.  

 
Class/interface Summary description 

CMODApplicationGroup  Represents an IBM® Content Manager OnDemand 
(CMOD) application group that can be configured for 
content federation. An application group is a 
collection of one or more OnDemand applications 
with common indexing and storage management 
attributes. 

CMODApplicationGroupSet  A collection interface that represents a collection of 
CMODApplicationGroup objects. 

CMODFixedContentDevice  Represents the description of an IBM® Content 
Manager OnDemand (CMOD) external fixed content 
storage device. 

CMODFixedContentDeviceSet  A collection interface that represents a collection of 
CMODFixedContentDevice objects. 

CMODRepository  A replication interface that represents an IBM 
Content Manager OnDemand (CMOD) external 
repository that is capable of federating content. 

CMODRepositorySet  A collection interface that represents a collection of 
CMODRepository objects. 
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ContainmentName  A constants class that provides a set of constants 
that specify illegal containment name characters.  

ContentFederatingRepository  A replication interface that represents repositories 
that are external to the Content Engine server and 
are capable of federating content. This interface is 
the base for subinterfaces representing external 
repositories that are capable of federating content. 

ContentFederatingRepositorySet  A collection interface that represents a collection of 
ContentFederatingRepository objects. 

DirectoryConfigurationCA  Not supported. 

DirectoryConfigurationCAList  Not supported. 

DITARenditionEngineConnection  Represents site-specific connection data for a DITA 
Rendition Engine that is referenced by a publishing 
configuration. (A DITA Rendition Engine is one that 
uses a DITA Open Toolkit deployment for publishing 
documents.) 

DITARenditionEngineConnectionSet  A collection interface that represents a collection of 
DITARenditionEngineConnection objects. 

ExternalAlias  A replication interface that represents the 
mechanism for mapping an external class or 
property to a corresponding Content Engine class or 
property. This interface is the base for subinterfaces 
representing external class and property aliases. 

ExternalAliasList  A collection interface that represents a collection of 
ExternalAlias objects. 

ExternalClassAlias  A replication interface that represents the 
mechanism for mapping an external class to a 
corresponding Content Engine class. 

ExternalClassAliasList  A collection interface that represents a collection of 
ExternalClassAlias objects. 

ExternalClassDescription  A replication interface that represents the description 
of a class in an external repository of which an object 
instance can be replicated. 

ExternalClassDescriptionSet  A collection interface that represents a collection of 
ExternalClassDescription objects. 

ExternalIdentity  A replication interface that represents the identity of 
a replicated object in an external repository. 

ExternalIdentityList  A collection interface that represents a collection of 
ExternalIdentity objects. 

ExternalParticipant  Not supported. 

ExternalParticipantList  Not supported. 
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ExternalPropertyAlias  A replication interface that represents the 
mechanism for mapping an external class property to 
a corresponding Content Engine class property. 

ExternalPropertyAliasList  A collection interface that represents a collection of 
ExternalPropertyAlias objects. 

ExternalPropertyDescription  A replication interface that represents the description 
of a class property in an external repository. 

ExternalPropertyDescriptionList  A collection interface that represents a collection of 
ExternalPropertyDescription objects. 

ExternalRepository  A replication interface that represents repositories 
that are external to the Content Engine server. This 
interface is the base for subinterfaces representing 
external repositories. 

ExternalRepositorySet  A collection interface that represents a collection of 
ExternalRepository objects. 

ImageServicesRepository  A replication interface that represents an IBM® 
FileNet® Image Services external repository that is 
capable of federating content. 

ImageServicesRepositorySet  A collection interface that represents a collection of 
ImageServicesRepository objects. 

ObjectStateRecordingLevel  A constants class that provides a set of constants 
that specify the audit recording level of the source 
object for an event of type ObjectChangeEvent. 

ObjectStoreParticipant  A replication interface that represents an object store 
participant of a replication group. 

ObjectStoreParticipantList  A collection interface that represents a collection of 
ObjectStoreParticipant objects. 

Replicable  A replication interface that is the base for 
subinterfaces representing classes of which an 
object instance can be replicated. 

ReplicableClassDefinition  Represents the class definition (mutable class 
metadata) of classes of which an object instance can 
be replicated. 

ReplicableClassDefinitionSet  A collection interface that represents a collection of 
ReplicableClassDefinition objects. 

ReplicableSet  A collection interface that represents a collection of 
Replicable objects. 

ReplicationConfiguration  Represents configuration settings for the replication 
components of a server. 

ReplicationConfigurationList  A collection interface that represents a collection of 
ReplicationConfiguration objects. 
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ReplicationDirection  A constants class that provides a set of constants 
that specify the direction in which instances of an 
external class, which is represented by an 
ExternalClassDescription object, can be 
replicated between a Content Engine object store 
and an external repository. 

ReplicationGroup  Not supported. 

ReplicationGroupSet  Not supported. 

ReplicationJournalEntry  A replication interface that represents the journal 
record of an operation on a replicated object for 
outbound replication. 

ReplicationJournalEntrySet  A collection interface that represents a collection of 
ReplicationJournalEntry objects. 

ReplicationJournalStatus  Not supported. 

ReplicationMode  Not supported. 

ReplicationParticipant  A replication interface that is the base for 
subinterfaces representing external repository or 
object store participants in a replication group. 

ReplicationParticipantList  A collection interface that represents a collection of 
ReplicationParticipant objects. 

Repository  A replication interface that is the base for 
subinterfaces representing object stores and external 
repositories. 

RepositorySet  A collection interface that represents a collection of 
Repository objects. 

SystemAddOnId  A constants class that provides a set of GUID 
constants that identify the AddOns provided by the 
system. 

New properties 

The following properties have been added to the Content Engine object model.  

 
Property Applies to Summary description 

AliasDirection ExternalAlias 

ExternalClassAlias 

ExternalPropertyAlias 

A ReplicationDirection constant 
that indicates the direction in which the 
mapping applies for this class or 
property alias. 

ApplicationGroupNumber CMODApplicationGroup The unique number identifying this IBM 
Content Manager OnDemand (CMOD) 
application group. 

CMODApplicationGroups CMODFixedContentDevice A CMODApplicationGroupSet 
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object containing the set collection of 
application groups defined in the IBM 
Content Manager OnDemand (CMOD) 
external repository associated with this 
CMOD fixed content device. 

CMODLanguage CMODFixedContentDevice A value for the IBM® Content Manager 
OnDemand (CMOD) external repository 
associated with this CMOD fixed 
content device that indicates the 
language in which messages will be 
output. 

CMODPassword CMODFixedContentDevice The password for the security principal 
identified by the CMODUserName 
property. 

CMODPort CMODFixedContentDevice The port number on which the IBM® 
Content Manager OnDemand (CMOD) 
server associated with this CMOD fixed 
content device is listening. 

CMODServerName CMODFixedContentDevice The name of the IBM® Content 
Manager OnDemand (CMOD) server 
with which this CMOD fixed content 
device is associated. 

CMODTraceLevel CMODFixedContentDevice The amount of trace information that will 
be gathered by the IBM® Content 
Manager OnDemand (CMOD) external 
repository associated with this CMOD 
fixed content device. 

CMODUserName CMODFixedContentDevice The name of the security principal for 
accessing the IBM Content Manager 
OnDemand (CMOD) server associated 
with this CMOD fixed content device. 

ClassFamily ExternalClassDescription The symbolic name of the Content 
Engine root class (for example, 
"Document") to which the class 
described by this external class 
description corresponds.  

ClassIdentity ExternalClassAlias 

ExternalClassDescription 

ExternalPropertyAlias 

The identity of the external class 
described by this external class 
description, external class alias, or 
external property alias.  

DITADatabaseTimeout DITARenditionEngineConnection The database transaction timeout in 
seconds for DITA-specific publishing 
requests. 

DITAHome DITARenditionEngineConnection The fully qualified path to the directory 
where the DITA Open Toolkit is 
installed.  
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DITAJVMArguments DITARenditionEngineConnection The optional Java™ Virtual Machine 
(JVM) arguments that will be used to 
invoke the DITA Open Toolkit when 
publishing DITA content.  

DITARenditionEngineConnection PublishingConfiguration The 
DITARenditionEngineConnection 
object used by this publishing 
configuration. 

DITARenditionEngineConnection
s 

Domain The 
DITARenditionEngineConnection
Set object that lists the DITA Rendition 
Engine connections for this domain. 

DITAWorkingDirectory DITARenditionEngineConnection The fully qualified path to the working 
directory where DITA component 
documents will be downloaded from the 
Content Engine server for publishing via 
the DITA Open Toolkit.  

DatabaseIndexStorageLocation ObjectStore The location within the database in 
which index information is to be created 
and referenced.  

DatabaseLOBStorageLocation ObjectStore The location within the database in 
which Large Object (LOB) data is to be 
created and referenced.  

DatabaseTableStorageLocation ObjectStore The location within the database in 
which new tables are to be created and 
referenced.  

DateCheckedIn CodeModule 

Document 

PublishTemplate 

Versionable 

WorkflowDefinition 

XMLPropertyMappingScript 

The date and time that this document 
was checked in.  

DestinationRepository ReplicationJournalEntry Not supported. 

DuplicateSuppressionEnabled DatabaseStorageArea 

FileStorageArea 

Not supported. 

DynamicGroupMemberAttribute DirectoryConfigurationCA Not supported. 

DynamicGroupObjectClass DirectoryConfigurationCA Not supported. 

DynamicGroupQueryAttribute DirectoryConfigurationCA Not supported. 

ExternalAliases DocumentClassDefinition 

PropertyDefinition 

An ExternalPropertyAliasList 
collection of the external aliases defined 
for this property definition or replicable 
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PropertyDefinitionBinary 

PropertyDefinitionBoolean 

PropertyDefinitionDateTime 

PropertyDefinitionFloat64 

PropertyDefinitionId 

PropertyDefinitionInteger32 

PropertyDefinitionObject 

PropertyDefinitionString 

ReplicableClassDefinition 

VersionableClassDefinition 

class definition. 

ExternalClassDescriptions CMODRepository 

ContentFederatingRepository 

ExternalRepository 

ImageServicesRepository 

An ExternalClassDescriptionSet 
object containing the set collection of 
ExternalClassDescription 
objects associated with this external 
repository. 

ExternalObjectIdentity ExternalIdentity The unique identity of this external 
replica object, relative to the external 
repository in which it belongs. 

ExternalPropertyDescriptions ExternalClassDescription An 
ExternalPropertyDescriptionSe
t object containing the set collection of 
ExternalPropertyDescription 
objects associated with this external 
class description. 

ExternalReplicaIdentities Action 

ActionConsumer 

Annotation 

ChoiceList 

ClassDefinition 

ClassSubscription 

ClassWorkflowSubscription 

CodeModule 

ComponentRelationship 

Containable 

ContainmentRelationship 

CustomObject 

Document 

DocumentClassDefinition 

An ExternalIdentityList 
collection of the ExternalIdentity 
objects representing the identities of 
replicas of this object in external 
repositories. 
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DocumentClassificationAction 

DocumentLifecycleAction 

DocumentLifecyclePolicy 

DynamicReferentialContainmentRelat
ionship 

EventAction 

EventClassDefinition 

Folder 

InstanceSubscription 

InstanceWorkflowSubscription 

Link 

PropertyTemplate  

PropertyTemplateBinary 

PropertyTemplateBoolean 

PropertyTemplateDateTime 

PropertyTemplateFloat64 

PropertyTemplateId 

PropertyTemplateInteger32 

PropertyTemplateObject 

PropertyTemplateString 

PublishStyleTemplate 

PublishTemplate 

ReferentialContainmentRelationship 

Relationship 

Replicable 

ReplicableClassDefinition 

SecurityPolicy 

StoragePolicy 

SubscribableClassDefinition 

Subscription 

Versionable 

VersionableClassDefinition 

WorkflowDefinition 

WorkflowEventAction 

XMLPropertyMappingScript 

ExternalRepositories Domain An ExternalRepositorySet object 
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containing the set collection of 
ExternalRepository objects 
associated with this domain. 

ExternalRepository ExternalAlias 

ExternalClassAlias 

ExternalIdentity 

ExternalParticipant 

ExternalPropertyAlias 

The external repository associated with 
this replicated object, class or property 
alias, or external repository participant 
of a replication group. 

FcpPoolIdleTimeoutSeconds CMODFixedContentDevice 

CenteraFixedContentDevice 

FixedContentDevice 

GenericFixedContentDevice 

IICEFixedContentDevice 

IMFixedContentDevice 

SnapLockFixedContentDevice 

The number of seconds an idle 
connection can remain in the pool 
before being eligible to be closed and 
removed from the pool. 

FcpPoolMaxInUse CMODFixedContentDevice 

CenteraFixedContentDevice 

FixedContentDevice 

GenericFixedContentDevice 

IICEFixedContentDevice 

IMFixedContentDevice 

SnapLockFixedContentDevice 

The maximum number of concurrent 
connections to the fixed content device. 

FcpPoolMaxWaitSeconds CMODFixedContentDevice 

CenteraFixedContentDevice 

FixedContentDevice 

GenericFixedContentDevice 

IICEFixedContentDevice 

IMFixedContentDevice 

SnapLockFixedContentDevice 

The maximum number of seconds to 
wait for a connection once the 
FcpPoolMaxInUse limit has been 
reached. 

FcpPoolPreferredSize CMODFixedContentDevice 

CenteraFixedContentDevice 

FixedContentDevice 

GenericFixedContentDevice 

IICEFixedContentDevice 

IMFixedContentDevice 

The preferred size of the fixed provider 
pool. 
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SnapLockFixedContentDevice 

GroupUniqueIDAttribute DirectoryConfigurationCA Not supported. 

GroupUniqueIDAttributeIsBinary DirectoryConfigurationCA Not supported. 

HeldUntilDate ReplicationJournalEntry Not supported. 

IICEConfigurationServerURL IICEFixedContentDevice The URL that needs to be provided to 
the IBM Content Integrator API in order 
for it to locate the Configuration Server. 

InboundBatchSize ReplicationConfiguration Not supported. 

InboundBusyWaitInterval ReplicationConfiguration Not supported. 

InboundDispatcherEnabled ReplicationConfiguration Not supported. 

InboundIdleWaitInterval ReplicationConfiguration Not supported. 

LastFailureReason ReplicationConfiguration Not supported. 

MappableDirection ExternalPropertyDescription The direction in which the external 
property described by this external 
property description can be mapped for 
replication with respect to a Content 
Engine property. 

MaxInboundWorkers ReplicationConfiguration Not supported. 

MaxOutboundWorkers ReplicationConfiguration Not supported. 

ObjectStateRecordingLevel AuditDefinition The audit recording level of the source 
object for an event of type 
ObjectChangeEvent. (The source object 
is the object on which the event is fired.)  

ObjectStore ObjectStoreParticipant An object representing the object store 
in which the object resides.  

ObjectStoreSchemaDB2 Domain The default SQL script to use when 
creating object stores within a DB2 
database.  

ObjectStoreSchemaMSSQL Domain The default SQL script to use when 
creating object stores within a Microsoft 
SQL Server database.  

ObjectStoreSchemaOracle Domain The default SQL script to use when 
creating object stores within an Oracle 
database.  

OutboundBatchSize ReplicationConfiguration Not supported. 

OutboundBusyWaitInterval ReplicationConfiguration Not supported. 

OutboundDispatcherEnabled ReplicationConfiguration Not supported. 

OutboundIdleWaitInterval ReplicationConfiguration Not supported. 
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PartnerObjectStore ExternalParticipant Not supported. 

PropertyIdentity ExternalPropertyAlias 

ExternalPropertyDescription 

The identity of the external property 
described by this external property 
description or external property alias.  

RegionKey IsolatedRegion The encryption key for this isolated 
region.  

ReplicableDirection ExternalClassDescription The direction in which instances of the 
external class described by this external 
class description can be replicated. 

ReplicationData ExternalIdentity Provider-specific data for this external 
replica object. 

ReplicationGroup Action 

ActionConsumer 

Annotation 

ChoiceList 

ClassDefinition 

ClassSubscription 

ClassWorkflowSubscription 

CodeModule 

ComponentRelationship 

Containable 

ContainmentRelationship 

CustomObject 

Document 

DocumentClassDefinition 

DocumentClassificationAction 

DocumentLifecycleAction 

DocumentLifecyclePolicy 

DynamicReferentialContainmentRelat
ionship 

EventAction 

EventClassDefinition 

Folder 

InstanceSubscription 

InstanceWorkflowSubscription 

Link 

PropertyTemplate  

A ReplicationGroup object 
representing the replication group to 
which this replicable object belongs.  
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PropertyTemplateBinary 

PropertyTemplateBoolean 

PropertyTemplateDateTime 

PropertyTemplateFloat64 

PropertyTemplateId 

PropertyTemplateInteger32 

PropertyTemplateObject 

PropertyTemplateString 

PublishStyleTemplate 

PublishTemplate 

ReferentialContainmentRelationship 

Relationship 

Replicable 

ReplicableClassDefinition 

SecurityPolicy 

StoragePolicy 

SubscribableClassDefinition 

Subscription 

Versionable 

VersionableClassDefinition 

WorkflowDefinition 

WorkflowEventAction 

XMLPropertyMappingScript 

ReplicationGroups Domain Not supported. 

ReplicationMode ExternalParticipant 

ObjectStoreParticipant 

ReplicationParticipant 

Not supported. 

ReplicationOperation ReplicationJournalEntry Not supported. 

ReplicationParticipants ReplicationGroup Not supported. 

ReplicationStatus ReplicationJournalEntry Not supported. 

ReplicationTraceFlags TraceLoggingConfiguration Not supported. 

RestrictMembershipToConfig-
uredRealms 

DirectoryConfiguration 

DirectoryConfigurationAD 

DirectoryConfigurationAdam 

Restricts a group membership search to 
within the realms configured in FileNet 
Enterprise Manager.  
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DirectoryConfigurationCA 

DirectoryConfigurationIBM 

DirectoryConfigurationNovell 

DirectoryConfigurationSunOne 

SearchDynamicGroup DirectoryConfigurationCA Not supported. 

SuperclassIdentity ExternalClassDescription The identity of the immediate 
superclass of the class described by 
this external class description.  

SupersededAddOnIds AddOn 

UpgradeAddOn 

The IDs of AddOn objects superseded 
by this AddOn.  

TargetObjectStore CMODApplicationGroup 

ExternalClassDescription 

The name of the object store that will 
participate in content federation in this 
IBM® Content Manager OnDemand 
(CMOD) application group or to which 
this external class description belongs. 

UserUniqueIDAttribute DirectoryConfigurationCA Not supported. 

UserUniqueIDAttributeIsBinary DirectoryConfigurationCA Not supported. 

Deprecated properties 

The following properties on the IICEFixedContentDevice interface have been deprecated in this release: 

• CFSNamingFactoryInitia 

• CFSNamingProviderURL 

• LockDownExceptionList 

• LockDownPrincipal 

• LockDownPrincipalType 

In the Content Engine Java™ API, the accessor methods (that is, the get_<property> and set_<property> 
methods) for these properties have been deprecated. 

Content Engine Java and .NET APIs 

Support for DITA Publishing 

Support has been added for publishing Darwin Information Typing Architecture (DITA) documents using 
the DITA Open Toolkit as a rendition engine. To support this functionality, the following Content Engine 
API changes are introduced: 

• A new class, DITARenditionEngineConnection, provides site-specific connection data used by 
the DITA Rendition Engine and includes the following DITA-specific properties: 
DITADatabaseTimeout, DITAHome, DITAJVMArguments, and DITAWorkingDirectory. For more 
information, see FileNet P8 Documentation > Developer Help > Content Engine Development > Java API 
Reference > DITARenditionEngineConnection or FileNet P8 Documentation > Developer Help > Content 
Engine Development >.NET API Reference > IDITARenditionEngineConnection. 

• A new property, DitaRenditionEngineConnection, has been added to the 
PublishingConfiguration class. For more information, see FileNet P8 Documentation > 
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Developer Help > Content Engine Development > Java and .NET Developer's Guide > Reference > 
Properties by Class > PublishingConfiguration Properties. 

In addition, this release includes the new DITA Publishing Extension add-on, which does the following:  

• Extends the Document class to represent DITA topics (DitaTask, DitaConcept, and so on), maps 
(DitaMap and DitaBookMap), and processing profiles (DitaVal). 

• Extends the ComponentRelationship class to represent the relationships between files that make 
up a DITA project. 

• Adds a document classifier (DITA classifier) that assigns the appropriate Document and 
ComponentRelationship subclasses when a DITA document is checked in. After all of the 
documents that make up a DITA project have been checked in and classified, the DITA project is 
represented as a FileNet P8 compound document. 

Finally, the following items have been added to support DITA Publishing: 

• DITA-specific publish style template transformation options that specify the output format, DITAVAL 
file and title (optional), and whether to do a "copy-only" operation (so that you can process the files 
outside of the FileNet P8 system). 

• A DITA publish request handler that communicates with the DITA Open Toolkit to publish DITA 
documents.  

For more information, see FileNet P8 Documentation > Developer Help > Content Engine Development > 
Java and .NET Developer's Guide > DITA Publishing > Publishing Concepts or FileNet P8 Documentation > 
Developer Help > Content Engine Development > Java and .NET Developer's Guide > DITA Publishing > 
Publishing Concepts. 

Support for separate database tablespaces during object store creation 

Support has been added for creating separate tablespaces using a customized schema script when 
creating an object store.  (ecmdb00669763) 

A new factory method, Factory.ObjectStore.createInstance(domain, admins, users, 
schemaScript) is introduced. Using this method, you can submit a custom schema script that the 
server will use during object store creation. Use of a custom schema script overrides the values of the 
new ObjectStore properties that specify storage location of tables, indexes, and LOB columns within 
the database: DatabaseTableStorageLocation, DatabaseIndexStorageLocation, and 
DatabaseLOBStorageLocation. The custom script is derived from a factory-generated default script, 
which can be retrieved from a property on the Domain object. The property name corresponds to the 
database type: ObjectStoreSchemaDB2, ObjectStoreSchemaMSSQL, and ObjectStoreSchemaOracle. 
Typical modifications that a database administrator (DBA) might make to the script include the distribution 
of the various tables, indexes, and Large Object (LOB) columns across different tablespaces.  

For more information, refer to "Working with ObjectStore Objects" in the Content Engine Java and .NET 
Developer's Guide (IBM FileNet P8 Documentation > Developer Help > Content Engine Development > 
Java and .NET Developer's Guide), and the Content Engine API reference help for Java or .NET (IBM 
FileNet P8 Documentation > Developer Help > Content Engine Development > Java [or .NET] API 
Reference). 

Security and authentication 

Enhanced flexibility in user/group lookup 

The capability to restrict user and group lookups to only those in configured realms has been added. 
(ecmdb00750099) 

The RestrictMembershipToConfiguredRealms property has been added to the 
DirectoryConfiguration class and its subclasses to specify whether or not to chase all group 
memberships during user and group lookup operations.  
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For more information, see the Content Engine Java and .NET API reference help and FileNet P8 
Documentation > Developer Help > Content Engine Development > Java and .NET Developer's Guide > 
Security Concepts > Role-Based Security. 

Support for CMOD fixed content devices 

This release provides support for IBM Content Manager OnDemand (CMOD) fixed content devices. As 
part of this support, the following new classes and collection classes are introduced: 

• CMODApplicationGroup 

• CMODApplicationGroupSet 

• CMODFixedContentDevice 

• CMODFixedContentDeviceSet 

• CMODRepository 

• CMODRepositorySet 

The following properties are introduced: 

• CMODApplicationGroup.ApplicationGroupNumber 

• CMODApplicationGroup.TargetObjectStore 

• CMODFixedContentDevice.CMODApplicationGroups 

• CMODFixedContentDevice.CMODLanguage 

• CMODFixedContentDevice.CMODPassword 

• CMODFixedContentDevice.CMODPort 

• CMODFixedContentDevice.CMODServerName 

• CMODFixedContentDevice.CMODTraceLevel 

• CMODFixedContentDevice.CMODUserName 

For more information, see FileNet P8 Documentation > Developer Help > Content Engine Development > 
Java API Reference or FileNet P8 Documentation > Developer Help > Content Engine Development >.NET API 
Reference. 

New DateCheckedIn property 

This release introduces a new property, DateCheckedIn, which has been added to the Versionable 
class. This property specifies the date and time that a document was last checked in. Settability of this 
property is read-only for most users. Users who have been granted privileged write access can set this 
property on a document while it is being checked in. Otherwise, the server sets this property automatically 
on a document when it is checked in. 

For more information, see FileNet P8 Documentation > Developer Help > Content Engine Development > 
Java API Reference or FileNet P8 Documentation > Developer Help > Content Engine Development > .NET 
API Reference. 

New field for PersistenceType class 

This release introduces a new field, OWN_TABLE, which has been added to the 
PropertyPersistence constant class. The PropertyPersistence class provides a set of 
constants that specify whether a property can be made persistent (that is, have its state stored in a 
database). The new OWN_TABLE field specifies that a property has a dedicated table in the database 
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and therefore can be made persistent. This setting applies only to multi-valued scalar (non-object) 
properties and causes the server to store a property's values into a custom table, which is generated by 
the server when its property template is first assigned to a class definition as a property definition.  

For more information, refer to the Content Engine Java or .NET API reference help (IBM FileNet P8 
Documentation > Developer Help > Content Engine Development > Java [or .NET] API Reference). 

New auditing option 

A new option is available to be able to audit with or without including object state snapshots. You can 
choose to record these snapshots so that you can review an object before and after an event occurs on 
that object. Snapshots are recorded in the audit log and written to the database. Storing the serialized 
object being audited consumes large object (LOB) storage in the database, so you might wish to reduce 
or eliminate snapshot recording, depending on your requirements. You can set the new 
ObjectStateRecordingLevel property on the AuditDefinition object to specify which objects are 
recorded when an event fires for a source object change. You can specify that combinations of the 
original, pre-event object and the modified, post-event object be recorded, or you can suppress all source 
object recording.  (ecmdb00554270) 

New constant class for illegal characters in containment and folder names 

A new constant, ContainmentName, is exposed in the APIs that provides a list of illegal characters for 
containment names and folder names.  You can use the INVALID_CHARACTERS string to validate explicit 
containment and folder names before calling methods such as file (to file an object into a folder) or 
set_ContainmentName (to set an object's containment name) or set_FolderName (to name a new 
folder). (ecmdb00760311) 

Content Engine Web Service 

In Content Engine 4.0.x, Content Engine Web Service applications were limited to using the 3.5 WSDL, 
which supported Microsoft® Visual Studio® .NET 2003 with Web Services Enhancements (WSE) 2.0 SP2 
and IBM® Rational Application Developer 6.0. The 3.5 WSDL also supported DIME attachments and 
SOAP with inline, Base64 encoding for uploading and retrieving content data. 

In Content Engine 4.5, Content Engine Web Service applications can also use the 4.0 WSDL, which 
supports Microsoft Visual Studio 2005 with WSE 3.0. The 4.0 WSDL also supports Message 
Transmission Optimization Mechanism (MTOM) and SOAP with inline, Base64 encoding for uploading 
and retrieving content data.  The 4.0 WSDL does not support IBM Rational Application Developer Java 
clients.  

In this release, the use of the Direct Internet Message Encapsulation (DIME) standard to upload and 
retrieve content is deprecated. Support for DIME attachments will be dropped in a future P8 release. 
Because DIME support is deprecated in this release, the DIMEAttachmentReference and 
DIMEContent elements in the 4.0 and 3.5 DIME endpoints are also deprecated. Therefore, any 
existing .NET client applications that use DIME should be ported to work with the 4.0 endpoints and use 
either MTOM or SOAP with inline, Base64 encoding for content upload and retrieval. 

The 4.0 WSDL contains all of the elements, operations, enumerations, subelements, and attributes that 
are included in the 3.5 WSDL and introduces the following new elements: 

• ContentElementResponse 

• ContentErrorResponse 

• ContentRequestType 

• ContentResponseType 

• ElementSpecificationType 

• GetContentRequest 

http://wafogbert.uswa.ibm.com:8080/p84022/developer_help/content_engine_api/javadocs/com/filenet/api/core/Folder.html#set_FolderName%28java.lang.String%29_�
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• GetContentResponse 

• TakeFederatedOwnershipAction 

• UnevaluatedCollection 

The 4.0 WSDL introduces a new operation, GetContent.  

The 4.0 WSDL introduces the following new enumerations:  

• CollectionType 

• ListOfObjectListMode 

• StringEncodingType 

In addition, new attributes and subelements have been added to existing elements in the 4.0 WSDL, as 
follows: 

• CheckoutAction: ReservationProperties element and reservationClass attribute. 

• CreateAction: objectId and versionSeriesId attributes. 

• EnumOfObject: ParentReference attribute. 

• FilterElementType: levelDependents attribute. 

• ListOfObject: listMode attribute. 

• ListOfString: StringEncodingType attribute. 

• PropertyFilterType: levelDependents attribute. 

• ObjectSetResponse: collectionType attribute. 

• SingletonString: StringEncodingType attribute. 

• WithObjectIdentityType: serializationDuplicate attribute. 

For more information, see FileNet P8 Documentation > Developer Help > Content Engine Development > 
Web Service Developer's Guide. The documentation for the 4.0 WSDL is part of the P8 Platform Help. 
Documentation for the 3.5 WSDL is available on the IBM documentation Web site. Also available on the 
IBM documentation Web site are two new stand-alone Visual Studio 2005 sample applications, written in 
C# and Visual Basic, which use the new features of the 4.0 WSDL (including the GetContent operation). 

For more information about upgrading a 4.0.x application that uses the 3.5 WSDL to a 4.5 application that 
uses the 4.0 WSDL, see FileNet P8 Documentation > Developer Help > Upgrade Custom Applications. 

IBM Enterprise Content Management Widgets 

IBM Enterprise Content Management Widgets is a collection of widgets for use in rapid development of 
user interfaces for IBM FileNet P8 applications, which can lower the cost of building solutions. Using a 
graphical, browser-based tool, a designer drags and drops Enterprise Content Management (ECM) 
widgets and third-party widgets onto a Web page, sets the widgets' attributes, and wires the widgets 
together, defining inter-widget communications through the widgets' published and handled events. 
Wiring is automatic between most ECM widgets: the designer simply drops the ECM widgets onto the 
page to connect them. To connect ECM widgets to third-party widgets, the designer relies on an easy-to-
use wiring wizard. 

For this release, IBM Enterprise Content Management Widgets brings Business Process Management 
(BPM) functionality to Web pages “mashed up” (assembled) from diverse Internet and enterprise data 
sources. For example, a UI designer can easily combine ECM widgets with third-party widgets, such as 
stock tickers, location finders, and revenue trackers, to enhance the information value of a workflow. 
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IBM Enterprise Content Management Widgets is tightly integrated with the IBM FileNet P8 platform, 
requiring the back end services of the Process Engine and Content Engine servers, and the middleware 
services of the Process Engine REST Service and Workplace XT. The Process Engine REST Service 
enables communications between Web clients and Process Engine, and Workplace XT provides access 
to documents and other content that can be incorporated into workflows. 

Process Engine REST Service 

The REST Service is implemented as a servlet in the IBM FileNet Workplace XT application. This is a 
general-purpose RESTful service, and is used by IBM Enterprise Content Management Widgets. For 
more information, see FileNet P8 Documentation > Developer Help > Process Engine Development > 
Developer’s Guide > Process Engine REST Service. 

Content-Extended Operations for Component Integrator 

The new ContentOperations class supports content-extended operations (CEOperations) for IBM 
Content Manager, as well as the IBM FileNet Content Engine. For more information, see FileNet P8 
Documentation > Developer Help > Process Engine Development > Component Integrator Reference. 

Process Engine Java API 

New classes 

The ContentOperations class has been added to support content-extended operations for the 
Component Integrator: 

The following classes have been added to support IBM Enterprise Content Management Widgets and the 
REST Service: 

• VWApplicationSpaceDefinition 

• VWRoleDefinition 

• VWRole 

• VWRole.WorkBasketReference 

• VWWorkBasketDefinition  

• VWWorkBasketFilterDefinition 

• VWWorkBasketColumnDefinition 

• VWWorkBasketCollectionDefinition 

• VWWorkBasket 

• VWWorkBasket.Column 

• VWWorkBasket.Filter 

• VWWorkBasket.QueryResults 

New methods 

The following methods have been added to existing classes to support IBM Enterprise Content 
Management Widgets and the REST Service: 

• VWRole.fetchMyRole 

• VWRole.fetchMyRoles 

• VWQueueDefinition.addWorkbasketDefinition 
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• VWQueueDefinition.createWorkbasketDefinition 

• VWQueueDefinition.createWorkbasketDefinitions 

• VWQueueDefinition.createCopyOfWorkbasketDefinition 

• VWQueueDefinition.deleteWorkbasketDefinition 

• VWQueueDefinition.getWorkbasketDefinition 

• VWQueueDefinition.getWorkbasketDefinitions 

• VWQueueDefinition.getDeletedWorkbasketDefinition 

• VWSystemConfiguration.createApplicationSpaceDefinition 

• VWSystemConfiguration.getApplicationSpaceDefinition 

• VWSystemConfiguration.getApplicationSpaceDefinitions 

• VWSystemConfiguration.updateApplicationSpaceDefinition 

Workplace Application Toolkit 

The Workplace source code is no longer provided with the Application Engine software. However, it is 
available upon request. For information on how to obtain the Workplace source code, see FileNet P8 
Documentation > Developer Help > Workplace Development > Workplace Application Toolkit Developer's 
Guide. 
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Fixed APARs 
IBM FileNet P8 4.5 incorporates the APAR fixes that were originally distributed in the following fix packs 
and interim fixes. For details, see the associated fix pack and interim fix readmes. 

• P8AE-4.0.1-005 

• P8CE-4.0.1-006 

• P8CE-4.0.1-005.001 

• P8PA-4.0.1-001 

• P8PA-4.0.1-000.001 

• P8PE-4.0.2-001 

• P8PE-4.0.2-001.005  

• P8PS-4.0.0-006 

• P8RM-3.5.0-002 

• P8RM-3.5.0-002.001 

• P8RM-3.5.1-008 

• P8RM-3.7.0-004 

• P8RM-3.7.0-004.001 

• P8RM-4.0.0-002 

• P8RM-4.0.0-002.001 

• SPDL 2.2.0.1-FP001 

• SPWP 2.2.0.1-FP001 

• XTFP 1.1.2.4 FP004 

Fixes for the following APARs are also included in the 4.5 release. These reflect fixed defects that are not 
included in one of the fix packs or interim fixes listed above. 

Content Engine 

APAR Name 

Defect ID 
 

Description 

PJ32587 
743435 

 

Searches in Enterprise Manager Query Builder continue the query after the 
Maximum Results have already been reached. 

PJ34127 
745504 

 

An Install Shield limitation requiring a root user for installation has been removed. 

PJ34276  
753081 

 

The count for how many sub-folders and objects are in a folder is no longer available 
from the General tab of the Folder. 

PJ34317 
749262 

 

Unable to log into Enterprise Manager if password contains Unicode characters. 

PJ34333  
759316 

 

The P8 4.0 upgrade tool fails because it does not locate 
FNUPGRADE_40_TeamCollaborationManagerAddOn.xml. 

 
742961 

 

The Content Engine 4.0 installer does not find WebSphere Profiles if they are not 
located in the default location.  

 
743670 

 

The context root of a Content Engine cannot be changed on an application server. 

 
746307 

 

The 4.0.0b installer does not update the login-config.xml with FileNet security info 
when a DOCTYPE tag exists. 

 Asynchronous Event Action Triggers can be slow on Content Creation Events. 
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APAR Name 

Defect ID 
 

Description 

748802 
 

 
771564 

 

The BootstrapConfig JNDI change is not reflected in the GCD. 

 
687032 

 

Content Engine 4.0 Installer does not recognize the WAS profile if it is located other 
than default location. 

 

Records Manager 

APAR Name 

Defect ID 
 

Description 

PJ33216 
PJ33306 

 
 

A runtime exception occurs when navigating record categories  

PJ33422 
 

 

An error occurs when declaring a document as a record with Workplace XT 1.1.2 
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Known limitations 

Content Engine 

Limitation on deployment of event action handlers in code modules.  

As documented in the IBM FileNet P8 Content Engine Java and .NET API Developer’s Guide > Deploying 
Action Handlers, you can store an action handler as a CodeModule object in a Content Engine object 
store, or alternatively, you can specify the action handler in the Java Virtual Machine (JVM) classpath of 
the application server on which Content Engine is running. The referenced documentation provides 
guidelines for deploying event action handlers. In Release 4.5.0, the following additional guidelines and 
limitations are added for deploying event action handlers: 

• For event handler code on the JVM classpath: the logic of Java™ classes that are referenced by the 
event action handler, and that are found in the classpath, can call into the Content Engine Java API. 

• For event handler code in code modules: an event action handler in a code module can invoke Java 
classes that are on the JVM classpath as long as the logic of those classes in the classpath does not 
in turn call into the Content Engine Java API. Attempts to do so will fail. If you have designed such a 
deployment scenario, instead add the .class file that is making the API calls to the code module. The 
calls into the Content Engine Java API will then be supported. (ecmdb00761403) 

CFS-CMOD 
• Federated OnDemand extended mime type documents are not displayed in the Workplace XT 

CMOD Viewer. A Save dialog box is displayed instead. For viewing all issues through XT, please 
refer to the XT release notes and XT documentation. 
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Known Issues 
This section describes: 

• Independent software vendor issues related to P8 

• P8-specific known issues 

Where applicable, each issue includes an associated APAR name and defect ID for reference and 
tracking purposes. 

For some entries, known issues might be cited in multiple sections. For instance, an installation problem 
involving Content Engine might appear in both the Installation and the Content Engine sections.  

As these known issues are fixed, they will be moved to a corresponding section under Resolved Known 
Issues. 

For an overview of the 4.5.0 known issues that have been fixed by a service pack, fix pack, or interim fix, 
see the associated readme. 

Independent software vendor issues 

Application servers 

WebLogic 

 Description 

 A custom client application is subject to a repeatable query failure under the following 
conditions: 

• Content Engine is hosted by WebLogic 9.2 

• The client application depends upon the Content Engine EJB Transport 

• You are using the WebLogic wlclient.jar file 

If you encounter problems, restart the WebLogic server. This problem does not occur 
when using the weblogic.jar file. 

 With WebLogic 9x, the Bulk Declare Service (BDS) can use either wlclient.jar or 
weblogic.jar. However, weblogic.jar is not compatible with Java™ Runtime 
Environment (JRE) 1.4. JRE 1.5.x is recommended. 

WebSphere 

 Description 

 When you start WebSphere 5.x with Records Manager, you might see errors similar 
to the following: 
 
[10/11/07 16:55:27:720 EDT]    c42b5 WebGroup      E SRVE0020E: [Servlet 
Error]-[AdminServlet]: Failed to load servlet: 
java.lang.ExceptionInInitializerError 
 at 
org.apache.axis.transport.http.AxisServlet.<clinit>(AxisServlet.java:103) 
 at java.lang.Class.forName0(Native Method) 
 at java.lang.Class.forName(Class.java:141) 
 at 
org.apache.axis.transport.http.AxisServletBase.class$(AxisServletBase.java:95) 
 at 
org.apache.axis.transport.http.AxisServletBase.<clinit>(AxisServletBase.java:9
4) 
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 Description 
 at sun.reflect.NativeConstructorAccessorImpl.newInstance0(Native 
Method) 
 at sun.reflect.NativeConstructorAccessorImpl.newInstance 

These errors are internal to WebSphere and do not impact Records Manager or 
WebSphere functionality. They occur because a Records Manager setting causes 
incompatible JAR files due to the order in which the application files are loaded. 

Crystal Reports 

 Description 

 When a report needs to query a large number of (for example, 12,000) folders or 
records, paginating the report, as well as exporting the report can take a long time 
(several minutes). This is due to the load on the Crystal Reports server. 

Java Virtual Machine 

 Description 

 RecordsManagerSweep.sh requires the DISPLAY environment variable to be set in 
UNIX® environments. 
If RecordsManagerSweep.sh is executed in a UNIX environment without the 
DISPLAY environment variable set to a valid X Window display value, the Java 
Virtual Machine (JVM) throws java.lang.InternalError: “Cannot connect to X11 
window server”. This error is harmless and does not prevent the sweep from running. 

Workplace 

 Description 

 When a file is saved to a mapped network drive, the file might not show as tracked 
when it is checked back in depending on the user's permissions to the share.  

Workplace XT 

 Description 

780538 When using Mozilla Firefox 2, the CM8 Viewer locks up when trying to open a 
document for viewing. This problem does not occur when using Firefox 3 or when 
using FireFox 2 with JRE 1.6.0_10.  

To work around this problem, upgrade to the latest Firefox version or the most 
current supported version of JRE 1.6.  

Content Federation Services (CFS-CS and CFS-IICE) 

 Description 

 
779602 

 

During installation on Linux, when prompted for the JAVA HOME path, you must type 
in the path information; you cannot browse to the location This is an InstallAnywhere 
limitation.   
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Content Engine Web Service 

 Description 

 When running a Content Engine Web Service client application created in Visual 
Studio 2005 with Web Service Enhancements (WSE) 3.0 that uses the 4.0 Message 
Transmission Optimization Mechanism (MTOM) endpoint, you might experience high 
memory usage or an OutOfMemoryException exception when you stream large 
MTOM attachments. This problem occurs because WSE 3.0 buffers attachments 
before they are sent, potentially creating very large buffers. When using WSE 3.0, 
you cannot stream MTOM attachments without buffering. 

Microsoft has a WSE hotfix available that allows proper, non-buffered streaming of 
content uploaded over MTOM, which does not require the entire source content to be 
loaded into memory at once. For more information, see article 943508 on the 
Microsoft support site: http://support.microsoft.com/?id=943508. This hotfix is not 
available for general download; to obtain it, you must call 1-800-MICROSOFT.  

To stream MTOM attachments as they are sent from the client application to the Web 
server, you must modify the definition of the generated InlineContent class, applying 
techniques similar to those described in the following MSDN article: How to Stream 
Large Amounts of Data from a Web Service (http://msdn.microsoft.com/en-
us/library/aa528818.aspx).  

Content Engine Java and .NET API 

 Description 

 When running a .NET client application created in Visual Studio 2005 with Web 
Service Enhancements (WSE) 3.0, you might experience high memory usage or an 
OutOfMemoryException exception when you stream large Message Transmission 
Optimization Mechanism (MTOM) attachments. This problem occurs because WSE 
3.0 buffers attachments before they are sent, potentially creating very large buffers. 
When using WSE 3.0, you cannot stream MTOM attachments without buffering. 

Microsoft has a WSE hotfix available that allows proper, non-buffered streaming of 
content uploaded over MTOM, which does not require the entire source content to be 
loaded into memory at once. For more information, see article 943508 on the 
Microsoft support site: http://support.microsoft.com/?id=943508. This hotfix is not 
available for general download; to obtain it, you must call 1-800-MICROSOFT.  

FileNet P8 Platform Installation, Uninstallation, and Upgrades 

Content Engine 

APAR Name 

Defect ID 
 

Description 

 
777894 

 

The Content Engine and Content Engine Client installers do not generate silent 
response files for uninstalling, and the silent uninstall will remove all program 
components regardless of attempts to only uninstall a specific feature. This is a 
known issue with Install Anywhere, Issue# IOA-000034429. 

 
785417 

 

Before starting the Content Engine Client installation program on a machine that runs 
HP-UX, make sure that the PATH environment variable on the machine includes 
/usr/contrib/bin. Otherwise, the program will not find gzip and gunzip (located in 
/usr/contrib/bin) and will fail.  
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Content Search Engine 

APAR Name 

Defect ID 
 

Description 

 
785816 

 

In UNIX environments only, installing a Local Admin Server (other than the Master) 
creates k2adminstart/stop scripts with incorrect paths.  

 

Process Engine 

APAR Name 

Defect ID 
 

Description 

 
782145 

 

During Process Engine installation with a DB2 database, if an invalid BLOB 
tablespace name is entered, no error is returned. However, when saving security 
settings in Process Engine Task Manager, an error [Err=7900004c] is returned to the 
screen and is not written to any error log. 
Workaround:  
Assure that the BLOB tablespace name entered during Process Engine installation 
matches the actual BLOB tablespace name pre-defined by the database 
administrator. 

Application Engine 

APAR Name 

Defect ID 
 

Description 

 
383070 

 

When Application Engine is configured to use 1-box SSL redirect and Internet 
Explorer as the browser, the browser fails to load the graphics of the login page and 
it also fails to login.  

A workaround is to use different machine names in the http and https URLs. For 
example, use the machine name in one and use the IP address in the other. 

PJ35070 
661128  

 

Switching from WAR file to EAR file deployment. 

If you choose to deploy Application Engine as a WAR file and later decide to 
redeploy it as an EAR file, you must uninstall Application Engine and then reinstall 
the application, selecting EAR file deployment in order to add the required files to 
your setup. If this change of deployment type seems likely for your setup we suggest 
that you install Application Engine as if you would deploy an EAR file, which will 
create both WAR and EAR files, and then use the WAR file to deploy your web 
application.  

PJ35071 
664389  

 

During Application Engine 4.0.1 uninstallation, the uninstaller prompts the user to 
select whether or not to preserve custom-modified files. On upgraded systems the 
response is not registered correctly and custom-modified files are always deleted. 
During uninstallation of freshly installed Application Engines the uninstaller works 
correctly and preserves the files if requested. 

Application Engine shared directories must be mapped drives, not Windows shares. 

The Application Engine installer prompts for locations for the following directories: 
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APAR Name 

Defect ID 
 

Description 

• Configuration Directory 

• Upload Location 

• Download Location 

• Logfile Location 

On Windows, if these are shared directories you must map these locations to drives 
on the Application Engine server and enter the mapped drive information during 
installation.  

PJ35110 
759003 

 

When installing Application Engine on HP Itanium, finishing or cancelling the 
Application Engine installer program can result in a syntax error in the console. The 
error is harmless and can be ignored 

Content Engine  

APAR Name 

Defect ID 
 

Description 

 
747777 

 

Importing lifecycle actions with a code module requires an automatic retry. If a 
lifecycle event action references a code module, and both are exported together, the 
lifecycle event action can fail to import. This is because the lifecycle event action 
appears before the code module in the exported data. To correct this problem, check 
the Retry Failed Imports option on the Import Helper (Import Options Tab). When the 
code module successfully imports, the lifecycle event action import is retried and will 
complete successfully. 

PJ34144 
780949 

 

Files containing Portuguese characters cannot be indexed to a File Storage Area. 

PJ34999 
749735 

 

A null pointer exception occurs when checking in a document using a security 
template. 

PJ35002 
784915 

 

Enterprise Manager displays incorrect IS Data Type for F_DOCNUMBER. 

PJ35003 
753551 

 

The stop word list does not function correctly for the uni/en (Universal English) locale. 

 
782194 

 

BEA reports the following problem with WebLogic 10 MP1.  

When a request with invalid credentials is rejected, the request immediately following 
it is also rejected with an authentication error (E_NOT_AUTHENTICATED), even if 
the second request contains valid credentials, and even if it comes from a different 
user. Valid requests after the second request are fine, and the workaround is 
therefore to resend the valid request. 

This problem occurs regardless of which host operating system or directory server is 
being used. 

This problem does not exist in earlier releases (including the base WebLogic 10 
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APAR Name 

Defect ID 
 

Description 

release), nor in WebLogic 10 MP2 or later. You can request a patch for WebLogic 10 
MP1 from BEA support by referencing Change Request number CR356815.  

Content Federation Services (CFS-IS and CFS-CMOD) 

 Description 

PJ34875 
782467 

 

A document federation update fails when a user re-maps an existing external 
repository field to a new Content Engine property.  

Content Search Engine 

APAR Name 

Defect ID 
 

Description 

PJ34997 
771529 

 

Multiple version numbers for Verity might be seen in CSE. 

PJ34998 
747682 

 

Performance problems occur when running CBR queries for exact matches. 

PJ35000 
777182 

 

Verity 6.2.2 K2 online documentation for supported platforms and file types is not 
current. 

PJ35001 
781008 

 

Performing the ‘k2adminstop’ operation does not function with Verity 6.2.1 on AIX 
6.3. 

PJ35004 
773204 

 

Verity sends index requests to the wrong index server. 

IBM Enterprise Content Management Widgets 

APAR Name 

Defect ID 
 

Description 

 
781723 

 

The names of ECM widgets that are intended to be hidden, ECM Create Work Item 
and ECM Create Action, are distorted when viewed in the hidden widgets corral. The 
distortion varies depending on the language for which the browser is configured. 

 
785473 

 

In the Step page with an ECM Step Complete widget, closing a work item with the 
close icon in the upper-right corner of the window might result in a lock-out condition 
if you later attempt to reopen the same work item. To avoid this issue, close the Step 
page window with the ECM Step Complete widget's Close button. 

This lock-out condition is accompanied by a "LockedByOthers" message, which is 
erroneous. The condition is, in fact, caused by a discrepancy between the way a user 
name is stored in LDAP and on the Process Engine server. 

Should you encounter this issue, you can unlock the work item using Process 
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APAR Name 

Defect ID 
 

Description 

Administrator.  

LO33481 
779752 

 

There is a known issue with how Lotus Mashups 1.0 displays widgets in a multi-
lingual environment. When editing a mashup page with Lotus Mashups, use the 
same browser language preference that is used to view the page. Otherwise, the 
page is likely to display incorrectly  

LO34408 
779110 

 

When using Internet Explorer 7.x, you cannot use the mouse to select text within 
some input fields of the ECM Work Data widget. However, you can click within a field 
and then use the keyboard to edit data.   

PJ35088 
781661 

 

In the ECM In-basket widget, when the last page is reached, the next-page button is 
erroneously enabled, and clicking this button navigates to a blank list in the in-
basket. To return to the list of work items in the in-basket, click either the previous-
page button or the first-page button.   

PJ35089 
781664 

 

If you launch Workplace XT from an IBM Enterprise Content Management Widgets 
mashup page, and if you later encounter an error message dialog box as the result of 
a Workplace XT operation, the dialog box's "Close Window" link will not work. To 
close the dialog box, click the "X" button on the top-right corner of the dialog box.  

PJ35090 
783278 

 

In the ECM Work Data widget, the edit window for adding or removing array data 
disappears if you click the window's vertical scroll bar. To avoid the problem, use the 
mouse's scroll wheel. Or, if your page permissions allow you to move widgets, move 
the ECM Work Data widget to the top or the bottom of the page so that the edit 
window displays completely, and then save the page setting.  

PJ35092 
786044 

 

IBM Enterprise Content Management Widgets supports only the 6.1.0.13 version of 
WebSphere Application Server (WAS), which is the version bundled with IBM 
Mashup Center 1.0. If you upgrade to WAS 6.1.0.17, you will be unable to log on to 
IBM Enterprise Content Management Widgets.  

Process Engine 

APAR Name 

Defect ID 
 

Description 

 
756934 

 

The 4.5.0 release supports Region Recovery for use with an Oracle database only. 
Microsoft SQL Server and IBM DB2 databases are not currently supported, but will 
be available in a future release 

PJ35065 
782220 

 

File menu items are not aligned correctly when using Sun JRE 1.5. 

 
783418 
783515 

 

The -L parameter purges event log records. If the Process Analzer option has been 
enabled on the Process Engine server, the -L parameter only purges records that 
have been processed by Process Analyzer.   

All records will be purged regardless of the PA option if a PA server has not been 
configured for the event log (PA can be configured to process records from only a 
subset of the event logs). 

PJ35064 Running the Process Engine client installer on HPUX Itanium returns an error “No 
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APAR Name 

Defect ID 
 

Description 

771691 
 

java runtime ENV (JRE). 

Workaround:   Run the HPUXi client installer with the following command: 

./P8PE-CLIENT-4.5.0-HPUXI.BIN -is:jvmtimer 10  

This gives the installer more time to complete JVM verification.  The default value is 
5. 

PJ35109 
786497 

 

If special characters are used in the step name of a workflow, the event 
transformation information written in XML for the associated work class is invalid 
since the special characters are not escaped. 

Application Engine 

Workplace 

APAR Name 

Defect ID 
 

Description 

 
383681  

 

The Component Manager does not start on HP-UX systems running WebLogic. 

Workaround: Modify the routercmd.sh file to use the BEA-supplied JRE. Use a text 
editor to change 

<ae_install_path>/Router/JRE/bin/java  

to  

/opt/bea/jdk150_03/jre/bin/java  

The default value for <ae_install_path> is /opt/FileNet/AE  

PJ35050 
553411 

 

When running Workplace File Tracker in Windows Vista, an error message appears 
and you cannot use the Delete local file option. To work around this issue, it is 
recommended you add the Application Engine(s) on which Workplace is running to 
the Trusted Sites list in Internet Explorer. You can access this list in Internet Explorer 
by doing the following: 

1. In Internet Explorer, go to Tools > Internet Options. 

2. Click the Security tab. 

3. Click Trusted Sites and add the Application Engine(s) to the list of trusted sites.  

PJ35051 
554888 

 

When using Advanced Search via the Quick Search portlet running on WebSphere 
Portal 6.0, selecting any search template results in a "404 file not found" error. You 
can avoid this error by setting the postThreshold parameter to -1 in the web.xml file, 
which is located in <install location>/Workplace/WEB-INF/web.xml. After making this 
change, re-pack the war file and re-deploy Workplace for the changes to take effect. 
Refer to Task 28a-c in the IBM FileNet P8 Installation and Upgrade Guide for more 
information on deploying Workplace and packaging the war file. 

Following is an example of the postThreshold setting in the web.xml file: 

<context-param> 

        <param-name>postThreshold</param-name> 
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APAR Name 

Defect ID 
 

Description 

        <param-value>-1</param-value> 

 </context-param>  

PJ35052 
555596 

 

When you access Workplace from the Mozilla Firefox browser version 2.0.x, multi-
select various documents that contain spaces in their document title, and then use 
the Download action, the Open with WinZip option is not available. The workaround 
is to use Internet Explorer. 

PJ35053 
381961 

 

Errors can occur when saving a search template in the Search Designer. Work 
around this memory problem with the Java environment by using the following 
parameter for the JRE:  -Xms 1024m  -Xmx 1024m. 

PJ35054 
374956 

 

McAfee Virus Scanner 8 has a default setting to block port 25 in order to stop Mass 
Mailing worms. This also blocks access to the exchange server and must be disabled 
or removed before the connection can be restored. (This issue also affects Process 
Engine  DTS 183503 for information.) 

PJ35055 
383192  

 

The Max number of search results is incorrect for simple search in Workplace and 
the Portlet Quick searches. 

PJ35056 
741802 

 

Firefox has a new feature in which you are prompted for the latest available JRE if no 
JRE is installed and not prompted for a JRE if any JRE is installed (even an older 
version). This is contrary to Internet Explorer behavior as well as legacy Firefox 
behavior (1.x), This is a designed function. Firefox might prompt you to get a JRE 
that is not supported by Workplace XT or might not prompt you to update your JRE at 
all. If this occurs, you need to manually pick up the supported JRE provided by 
Workplace XT. This affects both Workplace and Workplace XT. 

If the client has a JRE that is older than the supported JRE version (for example, 
1.4.2_0), when the Workplace XT user launches an applet (such as Search Designer 
or Viewer) from within a Firefox browser, the user is not prompted to install the 
supported JRE that ships with Workplace XT. Instead, the applets are launched 
using the client’s current JRE. 

The "Use Java Applets" topic needs to be updated to include the following 
instructions to download the JRE provided with Workplace XT before launching 
applets.  

1. Log in to Workplace XT. 

2. Go to http://<servername:port>/WorkplaceXT/download/jre-1_5_0_11-windows-
i586-p.exe, where <servername:port> is the name and port number of your server. 

3. At the Firefox prompt, download and save the installer file for JRE 1.5.0_11 on 
your local hard drive. 

4. Run the downloaded installer file to install JRE 1.5.0_11 on the client. 

5. Restart Firefox and proceed as usual to launch the applets. 

Note that these instructions are specific for JRE 1.5.  

PJ35057 
742693 

 

In Workplace, if you are using Internet Explorer 7.0, you may get a dialog box "The 
webpage you are viewing is trying to close the window? Do you want to close this 
window?" when you are attempting to close an Internet Explorer window.  This is a 
new security feature for Internet Explorer 7.0 and cannot be disabled. Click OK to 
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APAR Name 

Defect ID 
 

Description 

continue working. 

PJ35058 
779184 
779188 

 

When using P8 WebDAV integration with SSL, MS Office documents do not open. 

 

Workplace XT 

APAR Name 

Defect ID 
 

Description 

 
755620 

 

When you open an Excel workbook in Excel 2007 by using a hyperlink that contains 
a query string as part of the URL, you are incorrectly prompted that the workbook 
that you are trying to open is in a different format than the file name extension 
specifies.  

Application Integration BCS 

APAR Name 

Defect ID 
 

Description 

 
784150 

 

You can use an entry template to add and assign a specific document class to 
documents, and then check out the documents. However, if you modify that same 
entry template to assign a different document class, you cannot use that entry 
template to check in documents that were assigned the initial document class. 

 
785150 

 

When you upgrade to Workplace XT 1.1.3.0, the Application Integration BCS view 
site preference contain column name values that are blank.  

 
786069 

 

If you are using WebSphere and WorkplaceXT 1.1.3 is configured to use port 80, the 
Application Integration BCS download will fail with a 'Page Not Found' error. The 
workaround is to specify the WebSphere port, "WC_defaulthost," explicitly in the 
URL. 

PJ35094 
777762 

 

When you open a .pps or .pps file in a Microsoft Office application integrated with 
Workplace XT using Application Integration BCS, the file opens up directly into a 
slide show mode without any editing capabilities. As a result, you cannot see the 
commands available under the IBM ECM tab on the Microsoft Office 2007 Ribbon. 
To work around this issue and edit the file, open the document from your local file 
system after downloading it.  

PJ35095 
781999 

 

JAWS announces the incorrect number of items in a list view.  

PJ35096 
782001 

 

JAWS announces the incorrect number of items in a list view for a version series.  

PJ35097 During the installation process and after selecting Custom Setup, JAWS does not 
announce any of the static text in the Custom Setup dialog box. When you press 
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APAR Name 

Defect ID 
 

Description 

782006 
 

Insert + B, JAWS does not announce any information about the dialog box.  

PJ35098 
782008 

 

During the installation process and in the Custom Setup dialog box, the numerical 
positions of some of the features cannot be read in the feature tree view.  

PJ35099 
782340 

 

When you are selecting an entry template, JAWS does not announce the numerical 
position of the object store or entry template you are selecting.  

PJ35100 
782757 

 

When you open a new document in a new window in a Microsoft Office application 
integrated with Workplace XT using Application Integration BCS, the F6 key does not 
work if you want to move your focus from one window to another. The workaround for 
this issue is to press Shift + F6.  

PJ35102 
782782 

 

When you cancel a checkout after closing the currently checked out document and 
the Delete after canceling checkout site preference is set to Yes, the local copy of the 
document is not deleted from the local file system.  

PJ35103 
783112 

 

JAWS announces only the node name in an expanded tree view. It does not 
announce the additional levels and groups under a specific node.  

PJ35104 
783771 

 

If you are working with properties and an error message is generated, the screen 
reader cannot announce and read the message because it is located at the bottom of 
the properties pane.   

PJ35105 
784148 

 

During the installation process, if information is not entered in the Object Store name 
field or Preference name field, users cannot log into Application Integration BCS. 
There is no error message indicating information is missing and preventing users 
from logging in.  

PJ35106 
784887 

 

When you upgrade from Workplace XT 1.1.2 to Workplace XT 1.1.3, the Application 
Integration BCS view site preference does not contain default values for Columns 1-
3.  

 

Records Manager 

DoD Classified 

APAR Name 

Defect ID 
 

Description 

PJ34538 
368935 

 

Exceeding the string property maximum causes an error. 
Long string properties are limited to 256 characters. However, Records Manager does 
not monitor text input on every string property field for performance reasons. If you 
enter more than 256 characters, you can receive an error when sending the string.  
For example, in the DoD Classified data model, entering more than 256 characters in 
the Downgrade instructions field (Security Classification page) causes an error when 
you click Apply.  
To recover, click Return on the error message and modify the field to have no more 
than 256 characters. 
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File Plan Import and Export Tool  

APAR Name 

Defect ID 
 

Description 

PJ34539 
747704 

 

When exporting categories with identical partial paths, the tool concatenates the paths 
in the exported XML file. 
When a user employs the -o option to export categories with identical partial paths, the 
tool concatenates the paths in the resulting exported XML file. 
To correct the problem, manually edit the ParentPath attribute value of the 
RecordFolder entity. 

Globalization 

APAR Name 

Defect ID 
 

Description 

PJ34541 
664158 

 

When changing the encoding to Right to Left view, some popup windows do not 
display correctly. 

High Availability environments 

APAR Name 

Defect ID 
 

Description 

PJ34536 
766617 
766619 

 

In High Availability environments, Records Manager does not recognize the virtual 
server name so users must specify an active server name from the Configuration page 
of the Records Manager Transfer Tool, Records Manager Access Role Tool, Records 
Manager Creation Tool, and the Records Manager File Plan Import Export Tool.  

Record operations 

APAR Name 

Defect ID 
 

Description 

PJ34542 
769836 

 

When using container-managed authentication (CMA), and a user logs on using one of 
the following methods, and then logs off the application they first logged in to, the 
original connection remains valid.  

• Logs on to Records Manager from Workplace or Workplace XT using the 
Records Manager link 

• Logs on to Workplace or Workplace XT, from Records Manager using the 
Workplace link 

Consequently, if the user logs in again to the first browser session using a different 
user account, Records Manager adopts the user information of the first connection. 
This causes a credential conflict, and can cause a security violation when the user tries 
to declare physical records or perform some other similar action. 

Workaround: 

When logging off Workplace, Workplace XT, or RM, the user should close the browser 
window before logging back in. 
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APAR Name 

Defect ID 
 

Description 

PJ34325 
757291 

 

The Records Manager SendEmailOnSupercede event does not work properly when 
Records Manager uses JBoss as the application server. 

PJ34564 
775910 

 

When E-mail Manager is configured to declare an e-mail as a record, the DocURI field 
is populated with references to the attachments of that e-mail that have been 
separated and declared as records. The attachment references ensure end users can 
retrieve any associated attachments for that e-mail with ease. However, for each 
reference, a little less than 100 characters is used. If e-mails have more than 15 
attachments, E-mail Manager produces the following error due to the DocURI field    
exceeding 1333 characters:            
 
10/02/2007 15:35:16    Error An error occurred while         
attempting to populate the Record properties for the target file  
 
'C:\eMgr_temp\TA Numbers Requested for Fourth Quarter         
 
07.1F29632C2329D4E085257362005E1AED.0000.20071002153501.dxl'.   
Reason:              
The value specified for property Document Location exceeds the maximum permitted 
length. (error 0x80040229) 

PJ34557 
663975 

 
 

The Records Manager user interface has no mechanism to declare all parts of a 
compound document as a single record. However, users can declare individual child or 
parent documents as records. Documents that have already been declared as records 
can also become part of a compound document later. Certain compound document 
settings (such as “Prevent delete”, or “Delete child when parent is deleted”) can affect 
the normal disposition of a record. For this reason, Records Manager cannot support 
the disposition of records that are part of a compound document. 

PJ34543 
393090 

 

The Confirmation page does not display the copy name.  
When copying a record, the confirmation page displays only the name of the original 
record. It should display both the original name and the name of the copy. 

PJ34544 
388575 

 

Changing the display name of the record object store disables access to the content of 
records from RM. Do not change the ROS display name. 

PJ34545 
376949 

 

A search for "is null" or "is not null" incorrectly displays a drop-down choice list. 
In a Records Manager search for records where the user adds the Current 
Classification property and specifies a value of “is null” or “is not null”, Records 
Manager displays a choice list of values, which should only be seen with other kinds of 
operators. 

PJ34546 
376702 

 

Supersede property values are not visible. 
When you view the properties of a record as a user with read-only privileges, you will 
not be able to see the value for the Superseded Records field. Only users with Modify 
Properties access can see this information.  

PJ34547 
376031 

 

The export and import of some internal events fail when imported to a different object 
store. 
An internal events export contains two parts: 

• A list of all properties/operators/values (for example, Location = MyLocation) 

• A SQL statement for the query 
When exporting an internal event with a condition such as Location = MyLocation, the 
first part of the trigger contains the name of the location (for example, MyLocation), and 
the second part (SQL statement) contains the GUID of the location from the exported 
object store. 
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APAR Name 

Defect ID 
 

Description 

When reimporting the XML file into a new object store, the import tool recreates the 
location with a new GUID, but does not recalculate the SQL statement. (This is by 
design to enable the user to create more complex SQL statements than produced by 
the Records Manager UI).  
Therefore, the UI shows the appropriate value for the location (for example, 
MyLocation), but the sweep utility uses the SQL statement directly, and is unable to 
find any entity for this location (since sweep still uses the old GUID). 

PJ34565 
366283 

 

Records Manager and Workplace have different functionality during record declaration. 
When completing the Supersede and ReceiptOf properties during record declaration, 
Workplace users will need to select the file plan when navigating to the record. For 
Records Manager users, the default file plan is already selected. 

PJ34548 
365758 

 

An unnecessary blank window appears when viewing an Outlook record. 
After adding an email document to Workplace via Outlook Integration and declaring it 
as a record, an unnecessary blank window appears when you view the record in 
Records Manager. 
Workaround 
Close the extra blank window. 

PJ34549 
365068 

 

 “Receipt Of” info button causes error. 
With Retain Metadata enabled, destroying the record associated with a receipt leaves 
the link between the receipt and its associated record unchanged. The name of the 
associated record appears in the “ReceiptOf” property of the receipt along with an info 
button. Clicking the info button should display the associated record's properties in 
read-only mode. Instead, an error message informs you that the associated record was 
logically deleted. 

Reports 

APAR Name 

Defect ID 
 

Description 

PJ34550 
394513 

 

Printable view results are incomplete. 
The Printable View feature that is available in Search lists only the selected class. 
Even if you select "Include subclasses”, the additional classes are not listed. 

PJ34551 
394436 

 

The report titled “Electronic Records Viewed by a User within a specific period” report 
includes extra view events. 
This report lists all of the Get Content events captured by Content Engine, including 
view events that occurred on the document before it was declared as a record. 

Single sign-on 

APAR Name 

Defect ID 
 

Description 

PJ34552 
768478 

 
 

In an SSL-redirect environment, Records Manager 4.5 does not redirect users from the 
HTTPS URL to the HTTP URL.   
Because users are not sent to the HTTP URL, user sessions run in HTTPS mode and 
remain on the HTTPS server. As a result, the server hosting the HTTPS sessions has 
to handle more traffic than expected.  
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APAR Name 

Defect ID 
 

Description 

NOTE This problem applies to any container-managed authentication (CMA) 
configuration that has SSL-redirect configured.  

PJ34553 
775499 

 
 

 

Records Manager 4.5 supports WebSEAL from IBM Tivoli® Access Manager (TAM) for 
single sign on (SSO) configurations; in this environment, Records Manager is 
supported with both Workplace and Workplace XT.  
Records Manager 4.5 is also supported with Netegrity SiteMinder Web Agent; in this 
environment, Records Manager is supported with Workplace only.  
Records Manager 4.5 currently does not support other SSO providers or 
configurations, including Kerberos. 

User interface 

APAR Name 

Defect ID 
 

Description 

PJ34554 
384406 

 
 

 

The GUID displays instead of the name in Alternate Retentions. 
When you select either Location or Record Type for an alternate retention, the GUID 
displays instead of the name. This problem occurs both in the detail of the alternate 
retention and in the list of alternate retentions on the Phase Properties page. 

FileNet P8 Platform 

Workplace 

APAR Name 

Defect ID 
 

Description 

PJ34565 
366283 

 
 

 

Records Manager and Workplace have different functionality during record 
declaration. 
When completing the Supersede and ReceiptOf properties during record declaration, 
Workplace users are required to select the file plan when navigating to the record. 
For Records Manager users, the default file plan is already selected. 

PJ34556 
362429 

 
 

 
 
 

The Records Manager base URL stored in Workplace site preferences is not updated 
if the Records Manager application URL changes.  

The Records Manager base URL is stored in the Workplace site preferences and is 
set automatically when Workplace receives the first log in. If you change the 
Application Engine URL, the Records Manager base URL is not updated 
automatically. To continue linking Records Manager with Workplace, you must 
manually refresh the Records Manager base URL information in the site preferences 
whenever you do the following: 

• Configure Workplace to share an existing preferences file with another 
Workplace application. 

• Configure the entire Workplace application to run (or not to run) under SSL. 

• Change the hostname or port number used to access Workplace. 

To update the Records Manager base URL 

1. Determine the site preference name and the object store where the site 
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APAR Name 

Defect ID 
 

Description 

preferences are located.  

a. Log in to Workplace. 

b. Select the Admin tab. 

c. Click the Site Preferences link. 

d. On the site preferences page, click the bootstrap link. 

e. On the bootstrap page, note the Object Store Location for the object store 
that holds the preference file and Preference (the name of the preference 
file) under the "Preference Settings".  

2. Log in to Enterprise Manager. 

3. Locate the object store that holds the preference file and expand it.  

4. Navigate to the Root Folder > Preferences folder. 

5. In the Preferences folder, locate the file called "Site Preferences for <preference 
name>," where <preference name> is the name of the preference file. 

6. Check out the "Site Preference for <preference name>" file. 

7. In the checked out file, search for the following string: 

<setting key="RMBaseURL"> 

8. Replace the value of this <setting> tag to reflect the new base URL of the 
Records Manager application. 

P8 eforms 

APAR Name 

Defect ID 
 

Description 

PJ34868 
323303 

 

The JAWS screen reader does not recognize fields with the title on the side. 

PJ34871 
381897 

 

For versions of P8 eForms 4.0 and later, any data returned to a date or time cell from 
a lookup must be entered in canonical format. Dates must be in YYYY-MM-DD 
format regardless of the format configured for the cell. Times must be in HH:MM:SS 
format (including the seconds) regardless of the format of the cell. 

NOTE: Non-canonical data will work with P8eForms 3.5, Desktop eForms and Forms 
Manager. 

PJ34872 
381905  

 

You cannot tab to a form button. 

PJ34886 
386173 

 

The sample SQL code in the "Assessment" sample template that comes with eForms 
Designer 5.0.2 is incorrect. 

PJ34874 
387365  

 

Clicking the small signature icon brings up two Signature Verification dialogs with 
Mac/Safari 2.0.3. 
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Defect ID 
 

Description 

PJ34876 
387996  

 

In the eForms Designer help, the method described for changing the text style for a 
button label causes an "Object Required" error when the form is loaded in IBM 
FileNet P8 eForms and the button is disabled. 

PJ34877 
391743  

 

When a signature locks a large number of cells, navigation through the signature cell 
slows. 

PJ34878 
392320  

 

An error occurs when attempting to create a dynamic choice list in a table that 
provides the choices as values from other columns in the same row of the table. Two 
methods of creating this dynamic choice list are available: by referring to the column 
without reference to the row (<<Column1>>), and by referring to the column with the 
row specified using the Row function (<<Column1[Row]>>). Neither of these 
methods is currently working. 

PJ34879 
394352 

 

After setting a page to not printable with the Page.setPrintable method set to 
false, the page is still printed. 

PJ34870 
686524 

 

When opening an eForm directly by entering its URL in the Firefox 2.0 address field, 
the eForm will not close after clicking the Launch Workflow button or the Close button 
on the eForm. This behavior can be corrected by adjusting Firefox-2.0 settings in the 
following manner: 

1. Open a Firefox browser window. 

2. Type in "about:config" in the address bar. 

3. Scroll down to the " dom.allow_scripts_to_close_windows" entry and double click 
on the entry to switch the boolean condition to true. 

4. Close the browser window. 

 

Desktop eForms 6.0.1 

APAR Name 

Defect ID 
 

Description 

PJ34880 
359276  

 

The JAWS screen reader does not read page tabs. 

PJ34881 
365107  

 

The JAWS screen reader disabled menu items are read as enabled. 

PJ34882 
367046  

 

You cannot add documents with non-Latin1 characters in file names. 

PJ34883 
380330  

 

A lookup that returns a large amount of data into a table can cause the program to 
crash. 

 
661805  

 

Desktop eForms 6.0.1 can open ITXs and IFXs that are compatible with previous 
versions of Desktop eForms. This feature is not documented in the help. 
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Internationalization 

APAR Name 

Defect ID 
 

Description 

 
769201 

 

You cannot open an object store using Microsoft WebDAV if the folder you are 
opening contains non-English characters. 

IBM FileNet Connector for SharePoint Document Libraries 2.2.0 

APAR Name 

Defect ID 
 

Description 

 
758748 

 

During the post-processing task when documents are locked down, the crawling time 
increases for each query page. 

Documentation 

BAM 

APAR Name 

Defect ID 
 

Description 

 
785853 

 

In the Cognos LAVA installation documentation, the links for Creating Applicaiton 
Servers for WebSphere 6.0 and 6.1 do not find the correct topics. 
 
Workaround: Use the following link to access the documentation for WebSphere 6.0: 
http://publib.boulder.ibm.com/infocenter/wasinfo/v6r0//index.jsp 
Search for "Creating application servers". 
 
Use the following link to access the documentation for WebSphere 6.1: 
http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1//index.jsp 
Search for "Creating application servers". 

 
785930 

 

The BAM online help topic "Import the IBM FileNet BAM Projects for a new 
installation" is incorrect.  

The topic discusses using a URL-based connection when configuring the JDBC 
agent on WebSphere; however, you should use a datasource-based connection for 
all of the application servers. The updated Configure a JDBC Agent section should 
read: 

Configure a JDBC agent 

The VMAEDM_JDBC_AGENT is created after importing the OOTBConfiguration 
project, and is used to access data from the Process Analyzer database. The 
VMAE_JDBC_AGENT uses a datasource-based connection. By default, the JNDI 
name is com.celequest.context. Follow the IBM Cognos Now! documentation to 
configure a datasource for your particular application server type. The datasource 
created in this process should have a JNDI name that matches what is configured in 
the VMAE_JDBC_AGENT.    

http://publib.boulder.ibm.com/infocenter/wasinfo/v6r0/index.jsp�
http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp�
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Process Analyzer 

APAR Name 

Defect ID 
 

Description 

 
780258 

 

Scenarios that were created with Simulation Designer v3.5.2 might experience the 
following error when the simulation is run: 

"Java.lang.illegalArgumentException: Not participant field type F_Originator: int" 

Workaround:  

1. Make a copy of the scenario definition as backup. 

2. Open the scenario definition in Simulation Designer and remove the workflow 
that has F_Originator assigned as a participant for a step. 

3. Re-import the workflow and re-create any simulation properties that were 
previously set for the workflow. 

 
784730 

 

Microsoft SQL Server 2000 

Although it is mentioned in the online help, Microsoft SQL Server 2000 is not 
supported in this release. Instead, Microsoft SQL Server 2005 is required for all new 
installations or upgrades. 

Because Microsoft SQL Server 2000 is no longer supported, the "Work around the 
Microsoft Analysis Services 2000 64K limitation" topic is no longer relevant. 
Disregard this topic and any other mentions of Microsoft SQL Server 2000. 

Move the Process Analyzer database files topic 

The "Move the Process Analyzer database files" steps should be amended as 
follows:  

1. Use the Process Task Manager to stop PA. Stop the Process Analyzer Services 
Manager. 

2. In Microsoft SQL Server Management Studio (SQL Server 2005), detach the PA 
database. 

3. Move the PA data files <PADBname>mdf and <PADBname>.ldf from the default 
SQL Server data file location to your preferred location. The default SQL Server 
location is the Data folder in the SQL Server instance folder. 

4. In Microsoft SQL Server Management Studio (SQL Server 2005), attach the 
database and reference the new file location. 

5. Start the Process Analyzer Services Manager and use Process Task Manager to 
start PA. 

Note that the .mdf and .ldf file names will be different in your configuration, as these 
names correspond to whatever you named your database. Previously, these files 
were called VMAEDM.mdf and VMAEDM.ldf. 

Compress the Process Analyzer database 

The Compress the Process Analyzer database topic should include the following 
information for Step 3 and its substeps: 

3. If the PA database is installed locally, select Compress Database from the Action 
menu to start the Compression Wizard.  

If the database is not installed locally, you must run the compression wizard on the 
remote database server. To do so, perform the following steps on the remote 
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APAR Name 

Defect ID 
 

Description 

database server. 

a. The first time:  

i. Install the appropriate Microsoft SQL Server JDBC driver for SQL Server 
2005. You can download it from http://www.microsoft.com.  

ii. Create an installation folder (for example, C:\Process Analyzer).  

iii. Copy the _java folder from the PA Engine to the installation folder. The 
java folder is located directly under the installation folder.  

iv. Copy the following files from PA Engine to the installation folder. The files 
are located in the java folder directly under the installation folder:  

pa.jar  

paResources.jar  

pe.jar  

pe3pt.jar  

peResources.jar  

analyzer.properties 

b. Run the following command from the command line to start the compression 
wizard.  

For SQL Server 2005: 

<installDir>\java\bin\jre\bin\java.exe -Xms128m -Xmx300m –cp 
“<installDir>\pa.jar;<installDir>\paResources.jar; <installDir>\pe.jar; 
<installDir>\peResources.jar; <installDir>\pe3pt.jar;<MSSQL Driver 
Dir>\sqljdbc_1.2\enu\sqljdbc.jar” 
"Danalyzer.properties=<installDir>\analyzer.properties" 
filenet.pa.apps.rollup.RollupApplication -remote 

 
785913 

 

After installing the PA Client software using the silent installer, the shortcut to the 
Process Analyzer User Guide online Help does not work from the Programs list.  

Workaround: In the Programs list, locate PA documentation and right-click Process 
Analyzer User Guide. Select Properties and enter the correct URL in the target: 
<ECM documentation URL>/pa_help/userguide.htm, where <ECM documentation 
URL> is the base URL you entered during the Process Analyzer Client installation. 

Desktop eForms 6.0.1  

APAR Name 

Defect ID 
 

Description 

PJ34884 
382803 

 

In the "Export records" and "Import records" topics, the Help does not say that users 
can export data in the XML File and eForms XML Data formats. In the "Export 
records" topic, the help does not say that the data for all cells will be exported even 
though users can select specific cells for exporting. 
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Records Manager 

User help 

Browser language settings  

APAR Name 

Defect ID 
 

Description 

PJ34392 

772439 
 

The following information will be included in a future refresh of the Records Manager 
documentation: 

When Records Manager has FileNet P8 components deployed in a JBoss environment 
or a WebLogic environment, and the browser setting is updated, properties might not 
display according to the new browser language until the cache has been refreshed. 

Restarting JBoss or WebLogic also corrects this error. 

NOTE Other clients that change the language will experience the same behavior before 
the cache refresh. 

PJ34393 

772425 
 

The following information will be included in a future refresh of the Records Manager 
documentation: 

Records Manager displays a localized interface according to the browser language 
setting. Tools that do not use a browser set the language according to the Records 
Manager server locale. 

NOTE If you change the browser locale when you are working in Records Manager 4.5, 
you must log out of your local Records Manager session, close the browser window, 
and log back in to Records Manager for the new locale setting to take effect. 

Hold Sweep and Disposition Sweep  

APAR Name 

Defect ID 
 

Description 

PJ34540 
775871 

 

The following information will be included in a future refresh of the Records Manager 
documentation: 

In the Preview Entities page that is used for reviewing the entities that match the hold 
criteria for executing Hold Sweep, the filter does not support the % or & characters. 

IBM Enterprise Content Management Widgets 

APAR Name 

Defect ID 
 

Description 

 
784203 

 

In the IBM Enterprise Content Management Widgets Reference, the "Payload Types" 
topic is missing information. In the WorkItemField payload type description, the 
following information should be included: 

NOTE For the "value" attribute, the JavaScript data type must match the type of the 
data field, as shown in the table. 
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APAR Name 

Defect ID 
 

Description 

Data Field Type "value" JavaScript type 

String string (e.g. "ECM Widgets") 

Integer number with no decimal places (e.g. 100) 

Float number (e.g. 3.14159) 

Boolean boolean (e.g. true or false) 

Time JavaScript Date object (e.g. new Date()). 

 
 

 
785819 

 

A configuration procedure having to do with FileNet P8 eForms is missing from the 
IBM Enterprise Content Management Widgets Installation Guide. If you have 
installed FileNet P8 eForms in Workplace XT, and if you want to use the ECM Create 
Action widget to launch workflows associated with eForms, then you must enter the 
Workplace XT base server URL in the Process Configuration Console. This 
procedure is covered in the FileNet P8 Documentation online help. Using the table of 
contents in the left pane of the online help, navigate to the topic User Help > 
Integrating Workflow > Workflow applications > Process Configuration Console > 
VWServices > View or Modify VWServices properties > Set web application 
properties. 

Content Java API Compatibility Layer 

APAR Name 

Defect ID 
 

Description 

 
755691 

 

Issue: The use of the Blowfish encryption algorithm for encrypting session tokens is 
replaced by the FIPS 140-compliant Advanced Encryption Standard (AES) algorithm.  
The Content Java API Developer's Guide and Content Java API reference help are 
not updated for the switch from Blowfish to AES.  

Resolution: The Content Java API Compatibility Layer documentation is no longer 
being updated. The sections of that documentation affected by the change to AES 
are provided below with the necessary updates. Note that some sections have been 
removed, while others are modified with the pertinent information. 

Security Concepts > Encryption Schemes 

The following topic has been reduced from two paragraphs to one: 

Symmetric Encryption Protection Level 

For a protection level of Session.SYMMETRIC, credentials are encrypted. 
Encryption is based on the encryption keys created by running the 
MakeCryptoKeys utility on the Web Application server. The generated keys are 
used with the Advanced Encryption Standard (AES) algorithm. For procedural 
information about setting up your environment for symmetric encryption and for 
manually generating a cryptographic keys file, refer to “Setting up Symmetric 
Encryption” in the “Configuration and the Content Java API” section. For details on 
MakeCryptoKeys and its output, refer to “Creating Cryptographic Keys for 
Symmetric Encryption” below. 
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APAR Name 

Defect ID 
 

Description 

Working with Security  

Creating Cryptographic Keys for Symmetric Encryption  

During Application Engine installation, the administrator can optionally select site-
wide symmetric credentials protection. This option causes the setup program to 
generate a CryptoKeyFile.properties file containing cryptographic keys. (You can also 
create cryptographic keys outside of the installation process by running the 
MakeCryptoKeys utility.) The generated keys will be used with the Advanced 
Encryption Standard algorithm. If you install multiple Application Engine servers, you 
can just copy one of these generated files to all of the Application Engine servers. 
Otherwise, each of the Application Engine server s will have different key files. The 
setup program also updates the WcmApiConfig.properties file with the selected 
protection scheme and the path to the CryptoKeyFile.properties file. 

The setup program places the CryptoKeyFile.properties file in an authentication 
folder on the Application Engine server. (The installation documentation specifies the 
default location, which differs by operating system type. However, the administrator 
can choose to move the file to another location and can update the 
WcmApiConfig.properties with the new location.)  

When configuring Application Engine for symmetric encryption during installation, you 
can specify that you want to generate limited strength or maximum strength 
cryptographic keys. If you select "Create maximum strength keys", then 256-bit keys 
are generated; otherwise, limited strength (128-bit) keys are generated. 

Java™ Development Kit (JDK) 1.4 (and later) includes the Java™ Cryptography 
Extension (JCE) with jurisdiction policy files shipped with "strong" but limited 
cryptography, which limit key length. Your application might encounter an 
"unsupported keysize" EncryptionException.  
This exception occurs under the following circumstances: 

• If you are using symmetric encryption with keys that are over a certain length.  

• If you are serializing Content Java API objects as parameters or return values of 
an EJB method and you have a CryptoKeysFile configured, even if you are not 
using symmetric encryption. (Internally, the serialization encrypts the credentials 
of the Session object that is contained in each Document, Folder, etc.)  

The EncryptionException occurs because the JDK includes the Java Cryptography 
Extension (JCE) with jurisdiction policy files shipped with "strong" but limited 
cryptography, which limit key length. To resolve the problem, see the 
“Troubleshooting Encryption Exceptions” topic below. 

Running MakeCryptoKeys 

When testing encryption of credentials tokens during your application development, 
you can run MakeCryptoKeys from a command line to manually generate one or 
more encryption keys. (You can display usage information by running the utility with 
no arguments.) Specify the number of keys and the size (in bits) of the keys to be 
generated. We recommend that you keep the number of keys to the minimum that 
will satisfy your security requirements (the default is 3). The default key size is 128 
bits. If you do not have the unlimited strength policy files, you should use keys of 128 
bits. If you specify a size greater than 256 bits, the utility generates a warning and 
reduces the value to 256 bits.  Due to initialization processing, a delay of several 
seconds is not unusual when MakeCryptoKeys starts. The utility writes its output to 
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APAR Name 

Defect ID 
 

Description 

standard output (System.out); redirect the output to a CryptoKeyFile.properties file. 
Edit the WcmApiConfig.properties file to add an entry specifying the full path to the 
key file. 

The following command creates three 256-bit keys, and redirects the output to a file. 
(This example assumes that your classpath is already set up to include the Content 
Java API JAR files.) 

java com.filenet.wcm.api.util.MakeCryptoKeys -n 3 -s 256 > 
CryptoKeyFile.properties 

To test, instantiate a Session object, specifying symmetric credentials protection for 
the credTag parameter of the method call, as shown below. (You can specify either 
the string "Symmetric" or use the Session.SYMMETRIC constant.) 

Session sess = ObjectFactory.getSession("com.example.apps.MyTestApp",  
    Session.SYMMETRIC, "tester", "testpswd"); 

 

Refer to the online help for the MakeCryptoKeys class for additional information. 

Configuring a Security Provider for a J2EE Application Server 
Environment 

This section, including its subtopics “Configuring for the Sun JDK” and “Configuring 
for the IBM JDK”, apply only to JDK 1.3.x and have been removed.  

Troubleshooting Encryption Exceptions 

This section provides information you can use to determine the cause of some 
frequently encountered EncryptionException messages. Note that the message text 
contains the location of the JRE, since a physical server can have multiple JREs 
installed. In addition, the message text contains additional information, where 
appropriate, for nested exceptions. The following exception text represents some of 
the common failures you might encounter that are related to misconfiguration of 
symmetric encryption or security providers, and pointers you can use to troubleshoot 
the problem. 

• com.filenet.wcm.api.EncryptionException: Problem creating JCE 
Cipher instance for AES/ECB/NoPadding algorithm. 
java.home=C:\java\jdk1.4.2\jre. Exception was 
java.lang.NoSuchAlgorithmException: Cannot find any provider 
supporting AES/ECB/NoPadding  

This exception indicates that no provider supplies AES. Since most providers do 
provide AES, this is probably indicative of a problem in the static configuration of 
java.security, static configuration of java.security has not been done, or the .jar 
file for the provider is missing from the classpath.  

• com.filenet.wcm.api.EncryptionException: Problem creating JCE 
Cipher instance for AES/ECB/NoPadding algorithm. 
java.home=C:\j2sdk1.4.2\jre. Cause: 
java.lang.ExceptionInInitializerError; Caused by: 
java.lang.SecurityException: Cannot set up certs for trusted CAs; 
Caused by: java.lang.SecurityException: Cannot locate policy or 
framework files!  

This exception, which traverses nested exception levels to get to the underlying 
failure, can be caused by a number of different problems, but generally means 
that there is a problem between the compatible levels of the JCE framework and 
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APAR Name 

Defect ID 
 

Description 

a specific JCE provider. For example:  

o Either the JCE provider is incompatible with the framework or vice versa. 
These components conduct mutual authentication checks of each other and 
will fail if found to be incompatible with each other.  

o JRE certifications (found in jre\lib\security\cacerts) might be expired. Consult 
your JDK vendor for the procedure to obtain new certifications.  

o Missing or misplaced policy files. Make sure that all policy files are available 
and in the proper locations.  

• com.filenet.wcm.api.EncryptionException: Problem initializing 
encryption/decryption with keyId 8110f2b1, size 256 bits. 
java.home=C:\java\jdk1.4.2\jre. Exception was 
java.lang.SecurityException: Unsupported keysize or algorithm 
parameters  

This exception indicates a keysize problem and occurs under the following 
circumstances:  

o If you are using symmetric encryption with AES keys that are longer than the 
keysize supported by your installed policy files.  

o If you are serializing Content Java API objects as parameters or return 
values of an EJB method and you have a CryptoKeysFile configured, even if 
you are not using symmetric encryption. (Internally, the serialization encrypts 
the credentials of the Session object that is contained in each Document, 
Folder, etc.)  

To resolve the problem, upgrade to an "unlimited strength" version of the policy 
files. See "Downloading the 'Unlimited Strength' Jurisdiction Policy Files" in the 
Java Cryptography Extension (JCE) topic at java.sun.com or the equivalent 
documentation from your JDK vendor.  

 
Content Java API Reference Help Updates 
 
The description of the MakeCryptoKeys class is changed as follows:  

 
public class MakeCryptoKeys  

extends java.lang.Object 

This class generates cryptographic keys for use with Symmetric encryption of 
session credentials tokens. The encrypted keys are used by the Advanced 
Encryption Standard (AES) algorithm.  

A site administrator is usually responsible for configuring site-wide security. However, 
when testing encryption of credentials tokens during application development, an 
application programmer might wish to run this utility to generate keys for the test. 
After generating the test keys and installing them on the Application Engine server, 
call getSession on the ObjectFactory class to instantiate a Session object, 
specifying Session.SYMMETRIC for the credTag parameter. 

You can display usage information by running MakeCryptoKeys with no arguments 
from a terminal command window. 
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APAR Name 

Defect ID 
 

Description 

Input to the utility is the number of keys to generate and the key size. Key size is 
specified as 128, 192, or 256 bits. The default key size is 128 bits. Specifying 192-bit 
or 256-bit key sizes requires use of unlimited strength security policy files. If you 
specify a key size greater than 256 bits, the utility generates a warning and then uses 
a key size of 256 bits.  The utility's output is written to standard output 
(System.out), which you redirect to a file (for example, CryptoKeyFile.properties). A 
delay of several seconds is not unusual when the utility starts. The following 
command creates three keys that are 128 bits in length, and redirects the output to a 
file: 

java com.filenet.wcm.api.util.MakeCryptoKeys -n 3 -s 128 > 
CryptoKeyFile.properties 

The Application Engine installation process creates an entry in the 
WcmApiConfig.properties file that identifies the default location of the CryptoKeyFile. 
The location differs depending on the type of installation performed and the platform 
on which the installation occurs. Refer to your installation documentation for the 
specific location for your environment. If the location of your CryptoKeyFile is 
different, use a text editor to create an entry in the WcmApiConfig.properties file that 
points to the correct location of your CryptoKeyFile.properties file. The following are 
two examples of such an entry: 

 CryptoKeyFile = C:\\filenet\\CryptoKeyFile.properties 

 CryptoKeyFile = CryptoKeyFile 

Keywords are case insensitive. In the first example above, note the use of double 
backslashes (\\) in the path statement of the entry's value portion. 
WcmApiConfig.properties is read as a Java PropertyResourceBundle. If your 
operating system uses backslashes as directory separator characters, the syntax 
requires that you double any literal backslash character that you use in the value 
portion of a keyword/value entry. If slashes are not used, you can specify the value 
with or without the ".properties" extension, as shown in the second example. 

The Content Java API reads the WcmApiConfig.properties file at runtime. It locates 
the CryptoKeyFile.properties file in the following manner: If the value specified for the 
CryptoKeyFile keyword contains a forward slash (/) or backslash (\) character, the 
value is read as the full and complete path name to the file that contains the 
encryption keys. If no path is specified, the Content Java API attempts to open 
CryptoKeyFile.properties according to the search scheme described in the Java 
ResourceBundle class. 

For more information, refer to “Key Configuration Files and Logs” in the Application 
Engine Administrator's help and Creating Cryptographic Keys for Symmetric 
Encryption in the Content Java API Developer’s Guide. 

Batching:  

Unless otherwise noted, the methods in this class are unaware of batching, and their 
behavior is undefined when a batch is active.  

Execution Venue:  

Unless otherwise noted, the methods in this class are executed locally. They do not 
make a network round-trip.  

See Also:  Security Concepts in the Content Java API Developer’s Guide 
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Notices 
This information was developed for products and services offered in the U.S.A.  

IBM may not offer the products, services, or features discussed in this document in other countries. 
Consult your local IBM representative for information on the products and services currently available in 
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only 
that IBM product, program, or service may be used. Any functionally equivalent product, program, or 
service that does not infringe any IBM intellectual property right may be used instead. However, it is the 
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this document. 
The furnishing of this document does not grant you any license to these patents. You can send license 
inquiries, in writing, to: 

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY  10504-1785 
U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property 
Department in your country or send inquiries, in writing, to: 

IBM World Trade Asia Corporation 
Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106-0032, Japan 

The following paragraph does not apply to the United Kingdom or any other country where such 
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES 
CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some 
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this 
statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are periodically 
made to the information herein; these changes will be incorporated in new editions of the publication. IBM 
may make improvements and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and do not in 
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part 
of the materials for this IBM product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate without 
incurring any obligation to you. 

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the 
exchange of information between independently created programs and other programs (including this 
one) and (ii) the mutual use of the information which has been exchanged, should contact: 

IBM Corporation 
J46A/G4 
555 Bailey Avenue 
San Jose, CA  95141-1003 
U.S.A. 

Such information may be available, subject to appropriate terms and conditions, including in some cases, 
payment of a fee. 
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The licensed program described in this document and all licensed material available for it are provided by 
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any 
equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. Therefore, the 
results obtained in other operating environments may vary significantly. Some measurements may have 
been made on development-level systems and there is no guarantee that these measurements will be the 
same on generally available systems. Furthermore, some measurements may have been estimated 
through extrapolation. Actual results may vary. Users of this document should verify the applicable data 
for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those products, their 
published announcements or other publicly available sources. IBM has not tested those products and 
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM 
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of 
those products. 

All statements regarding IBM's future direction or intent are subject to change or withdrawal without 
notice, and represent goals and objectives only. 

This information contains examples of data and reports used in daily business operations. To illustrate 
them as completely as possible, the examples include the names of individuals, companies, brands, and 
products. All of these names are fictitious and any similarity to the names and addresses used by an 
actual business enterprise is entirely coincidental. 

COPYRIGHT LICENSE: 

This information contains sample application programs in source language, which illustrate programming 
techniques on various operating platforms. You may copy, modify, and distribute these sample programs 
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing 
application programs conforming to the application programming interface for the operating platform for 
which the sample programs are written. These examples have not been thoroughly tested under all 
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these 
programs. 

Trademarks 
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business 
Machines Corporation in the United States, other countries, or both. If these and other IBM trademarked 
terms are marked on their first occurrence in this information with a trademark symbol (® or ™), these 
symbols indicate U.S. registered or common law trademarks owned by IBM at the time this information 
was published. Such trademarks may also be registered or common law trademarks in other countries. A 
current list of IBM trademarks is available on the Web at "Copyright and trademark information" at 
www.com/legal/copytrade.shtml. 

Adobe is a registered trademark of Adobe Systems Incorporated in the United States, and/or other 
countries. 

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other 
countries, or both. 

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or 
both. 

UNIX is a registered trademark of The Open Group in the United States and other countries. 

Other company, product, and service names may be trademarks or service marks of others. 

U.S. Patents Disclosure 
This product incorporates technology covered by one or more of the following patents: U.S. Patent 
Numbers: 6,094,505; 5,768,416; 5,625,465; 5,369,508; 5,258,855. 
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